Software and Hardware Requirements
You will need the following to run ABBYY Lingvo:
1. PC with a Pentium® 133 MHz processor or higher.
2. Microsoft® Windows® XP, Microsoft® Windows® 2000, Windows®
NT® Workstation 4.0 with Service Pack 3 or greater, Windows®
95/98/Millennium Edition.
3. 16 Mb of RAM for Windows®95; 32 Mb of RAM for
Windows®98/NT 4.0/Millennium Edition; 64 Mb of RAM for
Windows®XP/2000.
4. 20-135 Mb of free hard disk space for Lingvo 8.0 English-Russian
Edition;
60-270 Mb of free hard disk space for Lingvo 8.0 Multilingual
Edition depending on the number of components you choose to
install.
You will need an additional 130 Mb if you choose to install the
LingvoSound dictionary.
5. Sound card and headphones or loudspeakers (recommended).
6. Microsoft® Internet Explorer 5.0 SP2 or higher.
Microsoft® Internet Explorer 5.5 is included in the Lingvo package; you
will need 27 Mb of hard disk space to install IE 5.5.
7. CD-ROM drive and 3.5" floppy drive.
8. Mouse or other pointing device.
Note:
1. If you do not have enough free space on your hard disk, you can
choose the Run from CD option when installing Lingvo. Only the
program shell will be installed on your hard disk and all the
dictionaries will be left on the CD-ROM. In this case, you will need 20

Mb on your hard disk for the English-Russian Edition or 60 Mb for
the Multilingual Edition of Lingvo. In this mode the program works a
little bit slower and the Lingvo CD-ROM must be present in your
CD-ROM drive when you are working with Lingvo.
2. If your computer does not have a floppy drive, you can install Lingvo
by obtaining an Installation Code. Choose the Installation Code
option in the Installation Code dialog and follow the program’s
instructions. Note that obtaining an Installation Code may take some
time and you may need to re-run the setup program.

Installing Lingvo on your local computer
To install Lingvo on your computer:
1. Insert the CD-ROM in the CD-ROM-drive.
2. Click the Start button on the Taskbar and select Settings>Control
Panel.
3. Double-click the Add/Remove Programs icon.
4. Select the Install/Uninstall tab and click the Install button.
5. Follow the program's instructions.
Note:
1. When the program prompts you, insert the diskette with the
"Installation diskette" label (supplied with the ABBYY Lingvo 8.0
distribution package) in the floppy drive and continue the installation.
2. The installation program will run automatically (if you have not
disabled the CD autorun option). After step 1 you will see the
installation dialog. Click ABBYY Lingvo 8.0 to install Lingvo.
3. Instead of performing steps 3-5 you can run the Setup.exe program
from the ABBYY Lingvo CD-ROM.
In the Installation of additional features dialog you can decide whether
you want to install the LingvoSound dictionary and whether you want
ABBYY Lingvo to be integrated into Microsoft Word. In the same dialog
you can decide how information about dictionary configuration will be
stored in your system. You can either:
use a personal configuration for each user of this computer (in this
case the information about the attached dictionaries is saved for
each user separately), or
use a universal configuration for all users of this computer (in this
case the same set of attached dictionaries is displayed for all users).

Note:
To be able to save personalized settings in Windows 95/ 98/ME, go to
Control Panel>Passwords>User Profile and enable "User can
customize their preferences and desktop settings. Windows switches to
your personal settings whenever you log in".
You may need to obtain an Installation Code for the installation program
to run successfully. An Installation Code is necessary if:
·

Your computer has no 3.5" floppy drive;

·

You are installing ABBYY Lingvo from non-original or corrupted
media;

·

There are applications installed on your computer with which
ABBYY Lingvo may work incorrectly.

An Installation Code is generated from your Product ID and serial
number. You may obtain an Installation Code from ABBYY by filling out
a special form on the web-site specified by the installation program, by
sending the filled-out form to ABBYY by e-mail, or by calling the technical
support team at +7 095 234 44 00.
If you get error messages when installing the program, please consult the
Readme.txt file (you can find this file in the Readme folder on the Lingvo
CD-ROM). The information and advice contained in this file will help you
solve most problems you may encounter during the installation.
If you cannot obtain an Installation Code immediately, click Activate
Later in the Installation Code dialog and continue with the installation.
ABBYY Lingvo will be installed on your computer, but each time you start
the program, it will ask you to enter your Installation Code. After several
launches without an Installation Code Lingvo will cease to function.
Installing ABBYY Lingvo 8.0 English-Russian Edition
Complete All system components and dictionaries are installed.

Typical

Custom

Only the following dictionaries are installed: LingvoUniversal
(En-Ru), LingvoUniversal (Ru-En), LingvoEconomics (EnRu), LingvoComputer (En-Ru), LingvoThesaurus (Ru).
You can select the components and dictionaries to be
installed. By default only the typical components are
checked. You may wish to deselect some dictionaries to
save disk space.
In this dialog you can also decide whether to install the DSL
compiler on your system.

Only the program shell is installed on your hard disk and the
dictionaries are left on the ABBYY Lingvo CD-ROM. By
Run from choosing this option you can save disk space, but the
CD-ROM program will work slower and the ABBYY Lingvo CD-ROM
must always be in the CD-ROM drive when working with
ABBYY Lingvo.

Installing ABBYY Lingvo 8.0 Multilingual Edition

Complete All system components and dictionaries are installed.

Custom

You can select the components and dictionaries to be
installed. By default only the typical components are checked.
You may wish to deselect some dictionaries to save disk
space.
In this dialog you can also decide whether to install the DSL
compiler on your system.
Only the program shell is installed on your hard disk and the

Run from dictionaries are left on the ABBYY Lingvo CD-ROM. By
CD-ROM choosing this option you can save disk space, but the
program will work slower and the ABBYY Lingvo CD-ROM
must always be in the CD-ROM drive when working with
ABBYY Lingvo.

Network Installation
Installing Lingvo on a Network Server
Installation is performed by a network administrator.
To install ABBYY Lingvo on a network server:
From the command line, run setup.exe from ABBYY Lingvo CDROM with the /a parameter and then follow the program's
instructions.
Additional licenses
If ABBYY Lingvo is used by more than one user, you will need to enter
serial numbers of your additional licenses when installing Lingvo. For
this:
1. Run LicSetup.exe from \Program Files\ABBYY Lingvo 8.0 (the
network folder where ABBYY Lingvo was installed). The Add
License dialog will be displayed.
2. Enter the additional serial numbers and click the Add button.
Note:
1. If you have a large number of licenses, you can use a .txt-file to input
your serial numbers from.
2. You cannot use logical drives created by the SUBST command for
network installation.
3. Before beginning the installation, make sure that all users have readwrite permissions for the network folder \Program Files\ABBYY
Lingvo 8.0\Users.
Installing Lingvo on a Network Workstation
To install ABBYY Lingvo on a workstation:

Run Setup.exe from the network folder where ABBYY Lingvo has
been installed and follow the program's instructions.
Note:
1. You must have administrative rights for the workstation where you
install ABBYY Lingvo.
2. MS Internet Explorer is NOT automatically installed on the
server. The system should update the workstations before installing
ABBYY Lingvo (see "Software and Hardware Requirements" for
details).
Working with ABBYY Lingvo 8.0 over a network
If the message "Your LAN is running the maximum allowed number of
copies of Lingvo application." is displayed, check the number of
additional licenses you have added in the Add License dialog and the
number of users, that are working with ABBYY Lingvo at this moment.
Several users may work simultaneously with the same user dictionary
located on server. For example, they all can add cards to this dictionary
by choosing Create/Edit Card ... on the Tools menu or clicking

.

Translating words and phrases from other applications
(Microsoft Word, Microsoft Excel, Microsoft Internet
Explorer, Microsoft Outlook, Notepad etc.)
To translate a word or a phrase:
Select the word or phrase you wish to translate and press either
CTRL+INS+INS or CTRL+C+C.
You will see one of the following:
1. A card with suggested translations of the selected word or phrase.
This is the most common result you will get when translating single
words and short phrases.
2. Additional cards that may contain translations of various word-forms
of the query word, translations of words from the selected phrase, or
translations of parts of this phrase. All these cards will be generated
in response to your query – the longer the phrase, the larger the
number of cards that may be generated.
3. Translations window containing a list of card-headings
corresponding to your query. This window is displayed when more
than three cards have been found in response to your query.
You can open any of these cards by clicking on their headings.
4. Suggestions window with words similar to your query. This window is
displayed if the required word or prase has not been found in any
Lingvo dictionary.
5. The message "No entries found for query..." if there is no separate
card for your query word or phrase.
6. In Multilingual Edition only: If no translations have been found,
you may get a message asking you to choose another translation
direction. This message is displayed if Lingvo has been unable to
detect the source language of your query when translating from
another application.

More:
Magic keys
Translating words and phrases
Translations window

Translating words and phrases in Lingvo
To translate a word or a phrase:
1. Start typing your query word or phrase in the Edit Line. When the
necessary word or phrase appears in the Main Window, click
or
press ENTER. A card with suggested translations of the word or
phrase will be displayed.
2. Type your query word or phrase in the Edit Line and click
or
press CTRL+ENTER.
A card with suggested translations for the word or phrase will be
displayed, or you will see a Translations window or a Suggestions
window.
Note: When you type in a word and press CTRL+ENTER, Lingvo will
attempt to determine the primary form of the query word, Lingvo also
display a list of spelling suggestions if no translations have been found
for your query.

More:
Translating words and phrases
How can I change the current pair of languages?
Additional translation features
Suggestions window

Lingvo Main Window

Main Window buttons:
Open Card from Word List ENTER
Click this button to open the card for the word or phrase selected in the
Word List.
Translate Text from Edit Line CTRL+ENTER
Click this button to translate the text you typed in the Edit Line. Clicking
this button is similar to pressing CTRL+INS+INS or CTRL+C+C when
translating words from external applications. If more than three cards are
found in response to your query, a Translations window will be
displayed. If no exact matches are found for your query word, a
Suggestions window will be displayed containing a list of words similar
to your query.
Create/Edit Card CTRL+Num+

Click this button to create a new card in a user dictionary or edit an old
card.
Find Text from Edit Line CTRL+F
Click this button to perform a full-text search for the word you typed in the
Edit Line. Depending on your settings, Lingvo will search in the
dictionaries of the current pair of languages set on the Language bar, or
in all the active dictionaries.
Displays all the word forms of the word from the Edit Line CTRL+W
Click this button to see the paradigm of the word you typed un the Edit
Line. Lingvo will use the morphology of the source language selected on
the Language bar.
Close Temporary Cards SHIFT+Esc
Click this button to close all temporary cards.
Always on Top
Click this button (
) if you want all Lingvo windows to remain on top
even when you switch to other applications.
More:
Bookshelf. Working with dictionaries

Card window
Shows the entry of the selected word from overall Word List or search
list.

The card toolbar:
- Make card permanent/temporary (CTRL+T).
Click this button to make a card permanent/temporary. A permanent card
remains open until the user closes it. A temporary card is closed
automatically when the user opens other cards or clicks the Close
temporary cards button.
- Show brief/full translation (CTRL+NUM *)
Click this button to hide/unhide phrases and examples, as well as
synonyms and antonyms for the card’s headword.
- Sync contents (CTRL+S)
Click this button to place the card’s headword to the Edit Line and

highlight the headword in the Word List. Note that clicking this button (
may invert the translation direction.

)

- Find in card (F3)
Use this option to find words or phrases in the whole text of the card.
- Previous dictionary (ALT+UpArrow)
Click this button to see the card with the same headword from the
previous dictionary.
- Next dictionary (ALT+DownArrow)
Click this button to see the card with the same headword from the next
dictionary.
- List of active dictionaries
You see the name of the dictionary containing the card displayed on your
screen. Click on the arrow to the right to see the drop-down list with the
names of all dictionaries containing the query word.
Note: When Lingvo displays cards found during a full-text search, you
will notice certain differences:
1. Words «(search result)» are added to the window's caption.
2. The query words found in the text of the card are highlighted.
3. If your query word or phrase has been found in several
dictionaries, the entries from these dictionaries will be displayed
in separate cards.
To change card size and position:
1. Move the current card to the place on the screen where you want to
see cards open in the future.

2. Change the card’s size if necessary.
3. Click the
in the top left corner of the card and choose Save
position of primary card or Save position of secondary card for
the first and second opening card respectively. Move the card to the
place where you want to see it open next time.

Quick translation
(Translating words and phrases from other applications: Microsoft Word,
Microsoft Excel, Microsoft Internet Explorer, Microsoft Outlook, Notepad,
etc.)
Instead of typing you query in the Edit Line, you can translate it directly
from your current application by using Lingvo’s Magic Keys without
starting Lingvo.
To translate a word or phrase from another application:
Select the word or phrase you wish to translate and press
CTRL+INS+INS or CTRL+C+C.
You will see the Lingvo Main window and the search results for your
query.
By default, Lingvo will use the current pair of languages set on the
Language bar to translate your query word.
To change the translation direction:
Choose the necessary source and target languages on the
Language bar.
The following options are available for the Magic Keys:
Turn off the Magic Keys.
Choose only one Magic key combination for quick translation.
Forbid the use of the Magic Keys if Lingvo has not been launched.
To tune the Magic Keys:
Go to Tools>Options and check or uncheck the necessary items
on the Magic Keys tab.

Automatic language detection
When you use the Magic Keys to translate directly from other
applications, Lingvo will determine the source language automatically. By
default, both Lingvo English-Russian Edition and Lingvo Multilingual
Edition will select the source language from the current pair of
languages set on the Language bar.
In ABBYY Lingvo Multilingual Edition, you can ask Lingvo to select the
source language from the source languages of all the available
dictionaries.
To do this:
Go to Tools>Options, click the General tab and select All
languages of all active dictionaries in Languages used to detect
the language of a word when translating from other
applications.

Translating words and phrases in Lingvo
To translate a word or a phrase from the Lingvo Word List:
1. Choose a word or phrase from the Word List.
2. Choose Open Card from Word List on the Tools menu or click
or press ENTER.
Note: When typing a word or a phrase in the Edit Line, you jump directly
to the respective entry in the Word List. Therefore, when you press
ENTER or click
or select Open Card from Word List, you are
translating not the word from the Edit Line, but the respective entry you
have found in the Word List.
To translate a word or a phrase from the Edit Line:
Type a word or a phrase in the Edit Line.
Choose Translate Text from Edit line on the Tools menu or click
or press CTRL+ENTER.
Note:
1. There is a difference between translating a word from the Word List
and translating a word from the Edit Line. In the latter case, Lingvo
will try to break your phrase down into word combinations and use its
morphology engine when translating your query.
2. If there is a dictionary entry for your query, i.e. if your query is used
as the heading for one or more cards, the cards containing the entry
will be displayed.
3. If more than three cards are found in response to your query, a
Translations window will be displayed.
4. If no cards are found in any dictionary, a Suggestions window with a
list of spelling suggestions will be displayed.

5. When you translate a phrase, Lingvo will try to break your phrase
down into word combinations and search for them in the available
dictionaries. The search results are displayed in a Translations
window.
Lingvo translates words and phrases using the current translation
direction set on the Language bar.
To change the translation direction:
On the Language bar, select the source language from the dropdown the list to the left.
On the Language bar, select the target language from the drop-down
the list to the right.
To invert the translation direction:
Click the "Invert translation direction" button (
the drop-down lists on the Language bar.

) located between

Additional translation features:
1. You can translate any word you see on a card. (For details see
Translating a word or a phrase from card).
2. In ABBYY Lingvo Multilingual Edition, you can translate your
query word using all the available languages.
3. In ABBYY Lingvo Multilingual Edition, when translating from
another applications, you can either use the current pair of
languages (the default option) or all the languages of the active
dictionaries (For details see Working with several languages).
Attention! The length of your translated text fragment should not exceed
32 words!
More:
Suggestions window

Translations window
Translating a word or phrase from a card
ABBYY Lingvo Multilingual Edition Features

Translating a word or a phrase from a card
You can translate words or phrases you encounter while reading
dictionary cards.
To translate a word or phrase from a card, do one of the following:
On the card, double-click the word or phrase you wish to translate.
On the card, select the word you wish to translate, right-click your
mouse and choose Translate from the local menu.
On the card, select the word or phrase you wish to translate and
choose Translate into all languages from the local menu. (This
option is only available in Lingvo Multilingual Edition. For details
see Lingvo Multilingual Version Features).
On the card, select the word or phrase you wish to translate and
press CTRL+INS+INS or CTRL+C+C.
Whichever option you choose, Lingvo will translate the selected word as
if you were translating a word from the Edit Line.
Note:
1. Words in blue are hyperlinks. By clicking on these hyperlinks you
can open their respective cards from the same dictionary.
2. Words in green are labels. When you rest your mouse cursor on a
label, a question mark appears. Click on the question mark to see
the full text of the label.
3. For each word you see on a card the following options are available:
Translate, Show Paradigm, Copy to Edit Line, Copy to
Clipboard. Right-click on a selected word and choose the necessary
command from the local menu. All these options, except for Show
Paradigm, are available for any text fragment within a card.
In Lingvo Multilingual Edition you can also Translate into All

Languages any word or phrase from a card.
You can perform a full-text search for a word or phrase from a card using
all the languages of all the installed dictionaries.
To perform a full-text search for a word or phrase from a card using
all the languages of all the installed dictionaries:
On the card, right-click on the selected word or phrase and choose
Search in All Languages from the local menu.

Getting spelling suggestions
If Lingvo has been unable to find your query word in any of its
dictionaries, you may wish to check the word’s spelling.
If Lingvo has been unable to find the exact match for your query word, it
will display a Suggestions window containing a list of words similar to
your query.
To get a list of spelling suggestions:
Choose Suggest… on the Tools menu or press F7.

ABBYY Lingvo Multilingual Edition Features
1. You can use the languages of all the active dictionaries when
translating words or phrases from external applications (using
CTRL+INS+INS or CTRL+C+C Magic Keys).
By default, Lingvo will try to translate your query word using the current
pair of languages set on the Language bar. Therefore, when you switch
to a text in a different language, you will have to adjust the languages on
the Language bar accordingly.
In ABBYY Lingvo Multilingual Edition, you can use all the languages
of the active dictionaries when translating a word or phrase from another
application (using CTRL+INS+INS or CTRL+C+C Magic Keys). This
option can be useful if you work with texts written in several languages.
To translate a word or phrase from an external application using the
languages of all the active dictionaries:
Go to Tools>Options, click the General tab and select All
languages of all active dictionaries in the group Languages used
to detect the language of a word when translating from other
applications.
2. You can translate a word or phrase using all the languages
available in Lingvo.
If you are not sure of the language of the word or phrase you wish to
translate, you can choose Translate Using All Languages on the Tools
menu. Lingvo will try to translate your query word using all the languages
of the active dictionaries.
To translate a word or phrase using all the available languages:
1. Type your query word or phrase in the Edit Line.
2. Choose Translate Using All Languages on the Tools menu or
press SHIFT+

or CTRL+SHIFT+ENTER

Cards with translations for your query word will be displayed. If more than
three cards are found in response to your query, you will see a
Translations window containing a list of cards with translations. To the left
of the heading of each card its language is displayed. When you use
Translate Using All Languages instead of Translate, you will notice the
following differences:
1. Cards from dictionaries of various language pairs will be displayed at
the same time.
2. In the drop-down list of each card you will see a list of dictionaries of
the same translation direction.
3. The number of cards matches the number of translation directions in
which Lingvo has found translations for your query.
Example. Suppose you need to translate the word bat, but are not sure
which language the word comes from. Type bat in the Edit Line and
choose Translate Using All Languages on the Tools menu. Lingvo will
find bat in three languages: English, French and German.
Note: You will obtain the results described in the example above only if
you have installed all system dictionaries.
3. You can translate a word or phrase into all the languages
available in Lingvo.
In Lingvo Multilingual Edition, you can translate a word from a card into
all the available languages.
To translate a word from a card into all the available languages:
On the card, right-click on the word you wish to translate and select
Translate into All Languages from the local menu.
You will see the cards with translations of your query word into all the
languages available in Lingvo.
4. You can perform a full-text search for a word typed in the Edit
Line using all the languages of the active dictionaries.
To perform a full-text search in all the languages of all the active

dictionaries:
1. Type your query word in the Edit Line.
2. Choose Search in All Languages on the Tools menu or click
press CTRL+SHIFT+F.

or

5. You can perform a full-text search for a word from a card using all
the languages of the active dictionaries (in Multilingual Edition).
To perform a full-text search for a word from a card in all the active
dictionaries:
On the card, right-click on the desired word and choose Search in
All Languages from the local menu.
For details see:
Translations window
Suggestions window

Dictionary Specification Language
Starting with version 6.0, ABBYY Lingvo includes a DSL compiler
(Dslcomp.exe in the Lingvo folder) that can be used to create new
dictionaries which can be seamlessly integrated into the Lingvo
Bookshelf. You can share such dictionaries with your friends and
colleagues or even with the whole Lingvo community at www.lingvo.ru.
Using the DSL Compiler users can create cards that have the same look
and feel as cards from the system dictionaries.
Unlike custom dictionaries that can be created and updated directly from
Lingvo, DSL dictionaries are created using an external text editor and are
then compiled.
For details see:
Compile DSL a dictionary

Attaching and converting user dictionaries created in
previous versions of ABBYY Lingvo
To attach a user dictionary:
1. Choose Languages & Dictionaries... on the Tools menu.
The Languages & Dictionaries... dialog will open.
2. Click
in this dialog or press CTRL+O to bring up the Dictionary
Installation dialog box.
3. In the Files of type drop-down list select the required file type.
4. Select the dictionary or dictionaries you wish to install and click
Open.
Note: You can also drag and drop your dictionary file from Windows
Explorer onto the Bookshelf.
Lingvo 8.0 uses Unicode fonts to display text on its cards. Before you can
attach user dictionaries created in ABBYY Lingvo 5.0/6.0/6.5 and in
ABBYY Lingvo 7.0 English Russian Edition, you have to convert them
into the new multilingual format. If you try to attach an unconverted
dictionary, Lingvo will prompt you to convert them. If you agree and click
Yes, Lingvo will launch the DSL Compiler. The DSL Compiler will
convert your old file into the new format without altering its contents.
Note: There are certain restrictions on .lsd files that can be converted
into the new format (e.g. in their names, only the English and Russian
languages can be used). Therefore, we recommend that you re-compile
your old .lsd dictionaries if you still have their source files written in DSL.
Attention!
Dictionaries created in ABBYY Lingvo 8.0 cannot be attached to the
previous versions of Lingvo.
More:

How to compile a dictionary
Structure of a DSL dictionary entry (card)

Translation examples: how to use Lingvo
Lingvo will help you translate single words, phrases and sentences. Your
translations will take less time and will be more accurate and idiomatic if
instead of translating phrases word for word you translate them by using
collocations and set phrases (phrasal verbs, idioms, etc.).
Whenever you choose Translate Text from Edit Line on the Tools
menu or click
button, Lingvo will try to find collocations and set
phrases in your text.
To find and translate collocations and set phrases in your text:
Type your text in the Edit Line and choose Translate Text from Edit
Line on the Tools menu (or select a text fragment and click
CTRL+INS+INS or CTRL+C+C).
Lingvo will try to find collocations and set phrases in your text and
translate them.
Apart from set phrases and collocations, there will be free word
combinations in your text. To find a translation for a free word
combination, try choosing Find Text from Edit Line on the Tools menu.
To translate a free word combination:
Type your text in the Edit Line and choose Find Text from Edit Line
on the Tools menu.
Lingvo will perform a full-text search trying to find translations for your
free word combination in the text of dictionary entries (i.e. in the
comments and examples sections of dictionary cards).
The choice between the two commands often depends on whether you
are translating from or into a foreign language.
When you translate into a foreign language, you can easily single out
idioms and phrases in your text without the help of a dictionary. It is more

important to know whether you have to use a free word combination or a
set phrase in your translation. If you cannot find a separate card for a
phrase you wish to translate, try performing a full-text search (
Remember that you can tweak various search parameters
(Tools>Options>Search).
To perform a full text search:
Type your text in the Edit Line and click (

).

Note: Your text fragment cannot be more than 32 words long.
For details see:
Translation from a foreign language
Translation into a foreign language
Full-text search

).

Translating from Native Language into Foreign Language
Suppose you need to translate the following English sentence into
Russian:
The Labour Party made it clear that they will push through the
abolition of hereditary peers.
We can single out the following word combinations in our sentence:
Labour Party, to make it clear, push through, hereditary peers.
1. We see that Labour Party has its own entry in Lingvo and translates
as лейбористская партия.
2. Since make it clear does not occur as a separate entry in the
English-Russian dictionary, we perform a full-text search and find
these translations in the Russian English dictionary: давать
понять, давать почувствовать.
3. We open the card for push through and see that it means
проталкивать(ся). In the examples section we see that to push the
new law through is translated as провести новый закон. Note that
if you are not satisfied with these translations, you can also perform
a full-text search and find additional examples: push through a
resolution – протащить резолюцию, to push through unpopular
tax increases – проталкивать непопулярный закон об
увеличении налогов, etc.
4. We open the card for hereditary peer and see that it translates as
наследственный пэр.
5. We open the card for abolition and see that it translates as отмена,
аннулирование, ликвидация.
Now we can combine the results and translate the whole sentence into
Russian:

Лейбористcкая партия дала понять, что проведет закон,
отменяющий институт наследственных пэров.

Translation from a Foreign language
Suppose you need to translate the following Russian sentence into
English:
Ожидается, что во втором квартале цены на нефть вырастут,
так как страны-члены ОПЕК пообещали снизить уровень
добычи.
We start by opening the cards of the words we wish to translate.
Whenever we are not sure about how to translate a word combination,
we can perform a full text search to see if such a word combination
occurs somewhere in the dictionary entries. For example:

1. We see that ожидается
does not have a separate
entry in the dictionary, but we
can perform a full text
search. We can ask Lingvo
to find the exact match for
ожидается or even for
ожидается, что by going to
Tools>Options>Search
where we have to uncheck
the option Find all word
forms. After we have
performed a full text search
(
) we see that
ожидается, что translates
as It’s expected that/Smth. Is
expected to…
2. We open the card for
второй квартал and
translate it as second

quarter.
3. We perform a full-text search
for цены на нефть and see
from the examples that it
translates as oil prices or the
price of oil. Note that you
might wish to tweak search
criteria in
Tools>Options>Search to
find all the occurrences of
цены на нефть in Lingvo.
4. We open the cards for the
other words we wish to
translate.

Now we can combine the results and translate the whole sentence into
English:
Oil prices are expected to go up in the second quarter because
OPEC countries have pledged to cut production.

Working with the Grammatical Dictionary
The LingvoGrammatical dictionary is a hyperlinked English grammar
reference book. It has about 500 entries containing major grammatical
patterns, rules and examples. The dictionary contains information on
usage, differences between British and American English, pronunciation
variants, etc. It also deals with some finer points of English grammar (e.g.
it has cards for “give me this” and “give this to me”). The first (primary)
entry in the dictionary is Grammar, which contains links to six major
topics: Parts of Speech, Syntax, Speech situations, American and
British English, Spelling, and Punctuation. The entries are organized
in a hierarchical structure and you can go from a more general topic to a
more specific topic or vice versa by clicking on the respective links. Some
cards in the LingvoUniversal dictionary also have hyperlinks to the
LingvoGrammatical dictionary.
Working with the LingvoGrammatical dictionary is similar to working with
other Lingvo dictionaries, only you have to remember that instead of
translations it offers articles dealing with various grammar issues, as well
as rules and usage examples.
You can open the necessary cards from the LingvoGrammatical
dictionary by clicking on the respective links on some cards from the
LingvoUniversal dictionary or you can simply read the
LingvoGrammatical dictionary as a hyperlinked grammar book.
Entry structure and conventions used in the dictionary

Example
Suppose you need to translate the following Russian sentence:
Проходя мимо кухни, он остановился, чтобы выпить стакан
воды. Do you say:
Passing the kitchen, he stopped to drink a glass of water or
Passing the kitchen, he stopped drinking a glass of water ?
Type ing-form in the Edit Line and perform a full-text search. Lingvo will
find the following cards that will help you make the right choice:
Verb + to-infinitive or ing-form?
stop, go on + to-infinitive or ing-form
Once you have studied these cards, you will see that stop can be
followed by either a to-infinitive or an ing-form but with different
meanings: stop + ing-form means to finish an action in progress and stop
+ to-infinitive means to interrupt an activity in order to do something else
(the infinitive of purpose). Therefore the correct translation would be:
Passing the kitchen he stopped to drink a glass of water.

Menu
Edit
Cut CTRL+X
Copy CTRL+C
Paste CTRL+V
View
Arrange Cards CTRL+A
Close Temporary Cards SHIFT+ESC
Close All Cards SHIFT+F4
Previous Search Results
History CTRL+H
Always on Top CTRL+T
Language bar
Dictionary bar
Toolbar
Tools
Open Card from Word List ENTER
Translate Text from Edit Line CTRL+ENTER
Translate Using All Languages
Find Text from Edit Line CTRL+F

CTRL+SHIFT+ENTER

Search in All Languages CTRL+SHIFT+F
Show Word Paradigm... CTRL+W
Add Paradigm...
Suggest...
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Create/Edit Card... CTRL+Num+
Delete Card... CTRL+NumLanguages & Dictionaries... CTRL+D
Options... CTRL+O
Help
Help topics
Web-Links: On-Line Registration
Web-Links: On-Line Technical Support
Web-Links: ABBYY Home Page
Web-Links: Lingvo Home Page
About Lingvo

Font and color settings
You can set your own Card font (font used to display the card's contents)
and Word list font (font used to display words in the Word List). By
default it is Arial.
To change the font (for example, you'd like to set Times New Roman Cyr
for card contents and Courier New Cyr for the Word List):
1. Choose Options from the Tools menu.
2. In the displayed Options dialog, Format tab, choose Times New
Roman Cyr from the Card Font list and Courier New Cyr from the
Word List Font.
Important! For proper representation of cyrillic characters in the card and
Word List you should choose the font with cyrillic support (see the
operating system documentation for instructions on how to set up such a
font).
You can also choose the color for highlighted card words such as
references and labels (select Options/Format from the Tools menu).

"Card History " window
Opens the Card History window. You can see the list of all open cards
and search or translate queries made during the current Lingvo session.
Cards history - the list of all cards opened during the current Lingvo
session.
Queries history - the list of words typed in the Edit Line or pasted from
the clipboard.
The "Card history" window buttons:
- Open the card from word list. Opens the
card of the word selected in the search result
list.
- Sync contents. Synchronize list
contents. Places the card headword in the Edit
line and arranges the Word List so that the list
section containing the headword and its
environment is displayed.
- Clear contents. Clears the list.

"Search" window
This dialog displays a list of entries found for your query word. This list is
divided into the following sections:
cards in which the query word appears
as heading;
cards in which the query word
appears in the translation section;
cards in which the query word appears
in the examples section;
cards in which the query word appears
in the comment section.
Note:
1. Lingvo looks for a word or phrase in all
dictionaries. The name of the
dictionary in which the word has been
found is displayed to the right of the
word.
2. In Multilingual Edition you can also
use all the languages of all active
dictionaries when searching for a word
or a phrase.
"Search" window buttons:
- Open a card from the suggestion list. Click this button to open a
word card from the suggestion list.
- Sync contents. Click this button to place the card headword to the
Edit line and to arrange the overall Word List so that the headword and

words nearest it are displayed.
- Add search results. Click this button to enlarge the number of
entries meeting your query (if there are many).
- Reduce search results. Click this button to reduce the number of
entries meeting your query (if there are many).
- Change search parameters. Click this button to open the
Options/Search dialog for you to be able to modify the search
parameters.

"Translations" window
The Translations window displays the list of entries found for your
query.
The list is divided into the following sections:
cards in which the phrase searched in their
heading is contained;
cards in which the word searched in their
heading is contained.
"Translations" window buttons
- Open card. Click this button to open a card
from the suggestion Word List.
- Sync contents. Click this button to place the
card's headword to the Edit Line and to arrange
the overall Word List so that the headword and
words nearest to it are displayed.

"Suggestions" window
If Lingvo has been unable to find your query word in any of its
dictionaries, you may wish to check the word’s spelling.
If Lingvo has been unable to find the exact match for your query word, it
will display a Suggestions window containing a list of words similar to
your query:
The "Suggestions" window buttons:
- Open a card. Click this button to open a
card from the suggestion Word List. This button
functions in the same way as double-clicking the
selected word.
- Sync contents. Click this button to place
the card headword to the Edit Line and to
arrange the overall Word List so that the
headword and words nearest to it are displayed.

"Options" dialog - "General" tab
(multilingual version)
Option name Option description

Interface
language
Display card
with
references
and
examples
Copy the
Word List
item to Edit
Line during
Word List
browsing
Synchronize
Word List
language and
keyboard
layout
Display
Lingvo icon
on taskbar
Close all
temporary
cards when
switching to
another
application

You may choose either Russian or English. System
menus and dialogs are displayed in the language you
specified in this dialog box. To change the language,
select it from the list, click OK and restart Lingvo.
If this check box is selected, a full card including
examples, set phrases, synonyms, etc. is displayed.

If this box is checked, the program will copy the selected
Word List item to the Edit Line when browsing the Word
List.

If this box is checked, the translation direction is set as
your current keyboard layout.

If you check/uncheck this box, you can show/hide the
Lingvo icon on the Toolbar.
If you check this box, you make the system close all
temporary cards and some dialogs (the Search window,
the Translations window, the Card History window and
the Suggestions window) automatically when you
switch to another application.

Group
Languages used to detect the word's language when translating
from other applications:
(for ABBYY Lingvo Multilingual only)
This box is checked by default.
Working pair
When translating a word or a phrase in another
of languages
application Lingvo uses only languages of the current
only
translation direction.

All the
languages of
active
dictionaries
of Lingvo

If this box is checked, Lingvo will use all the
languages of all active dictionaries when
detecting the language and searching for
translation of the text from any application with
the help of the Magic Keys - CTRL+Ins+Ins or
CTRL+C+C.

"Options" dialog - "Magic keys" tab
You can tune the Magic Keys in this dialog.
Option name

Option value

Magic keys
Allows you to translate a word or phrase from any text by
Use Ctrl+Ins+Ins selecting a text fragment and pressing the specified hotkeys
for "quick translation".
Allows you to translate a word or phrase from any text by
Use
selecting a text fragment and pressing the specified hotkeys
Ctrl+C+C
for “quick translation”.
Magic keys are active
When this box is checked, you can translate words and
Always
phrases from other applications even if Lingvo is not launched.
Only when
When this box is checked, you cannot translate words and
Lingvo is
phrases from other applications if Lingvo is not launched.
launched
When I use magic keys in MS Office 2000/XP, the Clipboard window appears
sometimes.
"How can I fix
Click the >> button to see the Clipboard help section.
it?" button

"Options" dialog, "Search" tab
In this dialog you can specify search parameters to make your search
more flexible and productive. If you have pressed the
button in the
Lingvo Main window, ABBYY Lingvo will use search parameters you
have specified.
Option name
"Search type" group
Find cards containing
all the words typed in
Edit Line

Option value

Only the cards containing all words typed in
the Edit Line will be displayed (AND-search).

Check this box if you want ABBYY Lingvo to
match the distance between the words.
Maximum distance
Here you can specify maximum distance
between words
between words in your query.
Check this box if you want ABBYY Lingvo to
Match order
match the word order. Turn it on to filter the
cards you do not need.
Find cards containing The search will return those cards that contain
at least one word typed at least one word from the Edit Line. (“OR”
in Edit Line
search).
Uncheck this box if you want ABBYY Lingvo
to search for words in exactly the same form
Find all word forms
as in the Edit Line.
This box is checked by default.
Match distance

"Options" dialog - "Format" tab
In this dialog box you can specify the fonts used to display text in the
Lingvo Main Window (Word List) and Card Window.
Option name

Description

Font

Here you can choose the font used to
display the Word List in the Lingvo Main
Window.

Size

Here you can choose the size of the font
used to display the Word List in the
Lingvo Main Window.

Font

Here you can choose the font used to
display the contents of Lingvo cards.

Size

Here you can choose the size of the font
used to display the contents of Lingvo
cards.

References

Here you can choose the color in which
hyperlinks are displayed on Lingvo cards.
Choose the color you like from the Color
palette and click OK.

Word List
group

Card group

Here you can choose the color in which
grammatical, stylistic and other labels are
displayed.

Labels

Choose the color you like from the Color
palette and click OK.

Colors
group
Here you can choose the color in which
optional text is displayed (i.e. examples,
Optional text synonyms, antonyms, etc.)
Choose the color you like from the Color
palette and click OK.

Search
results

Here you can choose the background
color used to highlight search results.
Choose the color you like from the Color
palette and click OK.

"Languages & Dictionaries..." dialog
Option name

Option description

Language

Dictionary language. Only the dictionaries of the selected
language are displayed in the "Connected dictionaries"
list.
The list of attached dictionaries specifies what
dictionaries are present on the Lingvo "Bookshelf".

Dictionaries

The order of attached dictionaries in the list determines
their order on the Bookshelf. If a word is found in several
dictionaries, the card of the leftmost one will be opened
first.
Active dictionary - the dictionary the cards of which are
used during translation and full-text search; such
dictionary has a "tick". Inactive dictionary has no "tick", its
cards aren't used by the system, yet the dictionary may
be activated by the user at any time.

Add source
language
(monolingual)
dictionaries to the
bookshelf
Path to user
dictionaries
Update index button
Close button

Check this option to see source language (monolingual)
dictionaries on the bookshelves.
Here you can enter the path to your user dictionary or
choose it clicking the [...] button.
Click this button to update user dictionary index.
Click this button to close the window.

Languages & Dictionaries Toolbar:
- Create a new dictionary (CTRL+N)

Click this icon to create a new dictionary.
- Add a dictionary from a file (CTRL+O)
Click this icon to attach a new dictionary from a file.
- Remove a dictionary
Click this icon to remove a selected dictionary.
- Up (CTRL+Up)
Click this icon to move a selected dictionary up in the list of dictionaries.
- Down (CTRL+Down)
Click this icon to move a selected dictionary down in the list of
dictionaries.
- Dictionary information
Click this icon to see information about the selected dictionary (name,
author, etc).

"Paradigm" dialog
In this dialog you can see a list of all word-forms of the query word. The
grammatical structure of the paradigm depends on the language of the
word.
Note:
If you cannot see some words in the Paradigm window, use your mouse
to move the column separator to increase the column width.

"Primary Form" dialog
In this dialog you can define the primary form of the added word and
specify to which part of speech it belongs. Spelling peculiarities are also
defined here.
Option
name

Option description

Part of Speech group
Noun
Click this option button if you add a noun.
Adjective Click this option button if you add an adjective.
Verb
Click this option button if you add a verb.
Click this option button if you add an uninflected word (one
Uninflected
that doesn't vary in number, person, case, etc.).
Capitalization group
Specifies the word you are adding may have the very
Standard capitalization you set: all letters small, all letters capital, the
first letter capital, the rest small etc.
Sentence Specifies that the word you are adding is always
case
capitalized.
Specifies that the word you add is an abbreviation (the
As is
distribution of capital and small letters cannot vary - i.e.
GmbH is never written GMBH etc.).
Word you
add
Primary
form

Displays the word you are adding to the dictionary.
You may enter the primary form of the word being added
here or you may select it from the suggestions list.

"The Word is already in the Dictionary" dialog
Option name

Option description

Add button
Click this button to change the existing paradigm
Paradigm button Click this button to view the existing paradigm
Cancel button

Cancel the paradigm creation

"Adding Words Protocol" dialog
This dialog asks you questions in order to build the paradigm of the word
you are adding. To answer the question click Yes or No button. If you
gave a wrong answer click the Anew button to answer those question in
a different way.

If you are not satisfied with the constructed paradigm, answer No to the
"Is the word paradigm correct?" question. The system will try to build
another variant of paradigm.

"Create/Edit Card" dialog
Use this dialog to create new or edit already existing cards from user
dictionaries.
Option name

Type the
dictionary name

Create...

Option value

In this window you can type the name of the
dictionary containing you card or select required
dictionary from the drop-down list .
Opens the New dictionary dialog where you can
create a new user dictionary. The new dictionary
will be added to the list of user dictionaries and will
be opened by default in the Main Wndow. When
creating a new dictionary, be sure to specify its
source language and target language.
To detach a user dictionary or to remove it from
the disk:
Select the dictionary in the list and click the
Remove... button

Remove...

Type card name
Edit...
Close

Click this button to detach or remove user
dictionaries.
Click this button to enter a card heading.
Click this button to switch to the card editing
window. This window is empty if you are creating a
new card.
Click this button to close the Create/Edit Card...
dialog.

In order to attach or detach user dictionaries:

Select the Languages & Dictionaries... command on the Tools
menu. The Languages & Dictionaries... dialog box will open.

"Card" dialog
Use this dialog to type the text to be displayed on cards you create in
user dictionaries.
Option
name

Option value

Language Displays the language of the current word of the card edited.
All the card’s contents are displayed in this window. If your
card contains text fragments in a language different from the
target language (e.g. when you need to add examples in the
Card
original language), you have to specify the language of these
fragments manually. To do this, right-click your mouse and
select the necessary language from the pop-up list.
Allows you to save changes you have made to your card. If
the dictionary cannot build a paradigm for the card’s
heading, the program will ask you to build the paradigm
manually. If you press No, the word will be entered without a
paradigm. If you press Yes, a Primary form dialog will
appear.
Save
Note: If you are adding a word or phrase to a new user
dictionary, you will see the New dictionary dialog when
saving the card. You have to specify the source language
and the target language in this dialog.
Close

Closes the dialog.

DSL dictionary structure
The source dictionary text must be a plain text file. The dictionary text
may be typed either in UNICODE or in ANSI encoding.
A DSL dictionary is a sequence of dictionary entries. An entry (card)
comprises a heading (a word or a phrase) and card body. If a dictionary
is attached to the Lingvo system, all card headings are displayed in the
overall Word List, while card body (together with its heading) is displayed
in a card. The body contains a translation and/or comment. NB! This
comment, or explanatory notion, is information (for example, about the
history of the word) destined for the dictionary user, and should not be
confused with comment in the source dictionary text (serving for, say,
debugging purposes).
As the new version supports dictionaries not only in Russian and English,
but also in Italian, French, German etc. (see the full list of supported
languages in Supported languages section), the correct functioning of
your dsl-dictionary requires the special heading at the beginning of dslfile. This heading includes dictionary name (#NAME "dictionary name"),
source language(#INDEX_LANGUAGE "language name") and target
language (#CONTENTS_LANGUAGE "language name").
Ex.: Write the following heading at the beginning of the text file to create
the English-Russian dictionary named "General":
#NAME "General"
#INDEX_LANGUAGE "English"
#CONTENTS_LANGUAGE "Russian"
Note:
1. If the dictionary text was typed in ANSI encoding, you must specify
the codepage for the source text, i.e. add a codepage tag after tags
for target language and source language tags:
#SOURCE_CODE_PAGE
Allowed codepage names:

"codepage name".

Allowed codepage name Windows codepage number
Latin
1252
Cyrillic
1251
EasternEuropean
1250
2. In case you save the dictionary text in ANSI encoding, you should
remember that the dictionary source language and target language
must be supported by the same codepage. If there is no such
codepage, you must save the dictionary in UNICODE encoding.
3. In case you save the dictionary text in UNICODE encoding, you don't
have to specify the codepage.

Structure of dictionary entry (card)
How to compile the dsl-dictionary

Structure of a DSL card
A DSL card has the following structure:
1. The heading
Must be entered in the first position of a new line. The only symbols
you can use in the headingare: the alphabetical symbols of Russian
and English languages, numbers, space, -,'," and {} - to mark
unsorted part of the header.
2. The card body
Lines following the one containing the heading are the card body; the
symbol in their first position must be either a space (or several
spaces) or a tab (or several tabs). The end mark for card body is
either the heading of the next card (i.e., a non-space and non-tab
symbol in the first position of the line) or the end of file.
labels (by request)
translation section
comment section (by request)
example section (by request)
pictures or sound (by request)
references to web-pages (by request)
NB! The order of zone is not obligatory: you can put labels,
references to web-pages and pictures anywhere in the card body.
If the card body has too much information, you can reduce it for the
display. Mark a part of an card (for example, phrase section) as shown
only in full translation mode, and the part marked by you will be
displayed only when full translation mode is on. The rest of the card,
called brief translation, is displayed at all times. Any part of a card but
the heading can be marked as displayed only in full translation mode; you
can mark as many card parts as you want as such. If the full translation

mode is on, all card parts marked as such will be displayed; if this mode
is off, all card parts marked as such won't be displayed. As of now,
Lingvo uses a different color to display sections marked as displayed only
in full translation mode.
To mark a part of a card as shown only in full translation mode:
The beginning of the text is marked with the «[*]» tag, the end —
«[/*]» tag.
You can insert one or several blank lines between the body of one card
and the heading of the next one as it facilitates the reading of the source
dictionary text. Entries can be entered in any order you want (violating,
for example, the alphabetical order). You cannot enter two different
entries with the same heading. This restriction doesn't apply to headings
varying in case (you can have, for example, a card cardigan and a card
Cardigan, or even a card caRdigan).
How the headings are sorted
Text formatting
DSL tags
Subentry
Sample DSL entries

How the headers are sorted
A card heading can be both a word and a phrase. There can be any
number of spaced between the words forming a phrase. However, there
will be only one space displayed when it comes to displaying a card. A
space between words is accounted for when sorting the Word List.
A single card can have several headers. If you'd like a card to have
several headers, type all the headers first (each heading must begin a
line), then the card body according to the technique described above. All
headers are shown in the overall Word List (each heading in its own
place in alphabetical order); click anyone and the card body will be
displayed.
The overall Word List can display words in different languages at the
same time; both card and subentry headers are displayed. Each
language's words are sorted according to "natural" dictionary order (i.e.
alphabetical); all cyrillic letters are considered to follow all latin (x,y,z,а,б
etc.).
Certain non-letter characters are also accounted for when sorting. Among
these are colon, -, . (fullstop), ' (apostrophe), _, / (slash) etc.
You can use brackets in the heading to mark its alternative part, braces –
to mark its unsorted part. It is impossible to use square brackets ([ ... ]) in
the header.
Double braces mark a comment excluded from the dictionary text.
The use of #, @,<,> is disallowed; also forbidden are ~, ^ (you can use
them in subentry headers, though).
Using "\" (back slash)
Back slash (\) can be used before any symbol in the card.
If back slash is used before a symbol in the card it means that this
symbol is used as a text symbol, not as a special symbol. In this case
back slash will not be seen in the card.

If you want back slash to be seen in the card put double-black slash (\\).
You can not use #,@ symbols in card headings (except subcard
headings).
You can not use ~, ^ symbols in the first heading of a card. But you can
use them in other headings, e.g.:
card
green ~
For details see:
Using tilde
Unsorted part of the header
Alternative (non-obligatory) heading section

Unsorted part of the header
A heading can have an unsorted part. The unsorted heading part serves
to include in the heading certain linguistic information which helps to
understand how to use the heading word (what words the heading is
usually used with, government model examples etc.) yet, if it were sorted,
affects the heading position in the Word List in an undesirable way.
The unsorted heading part is not displayed in the overall Word List,
doesn't affect the word order in the Word List, isn't used when comparing
words. The meaning of all this is that when you add an unsorted part to a
heading you don't create a new heading, and so you can't use tilde to
denote both the heading and the unsorted part you added.
The unsorted heading part is displayed only on an open card. You should
use braces to select a part of the dictionary text as the unsorted part of a
heading. See the following example on the use of the unsorted heading
part:
{to }have
иметь

Alternative (non-obligatory) heading section.
The card heading in DSL can denote an alternative (non-obligatory)
section marked by brackets.
This feature allows you to mark certain spelling variants of a particular
word, or to denote that certain morphological distinction present in one
language are irrelevant in the other.
Example:
превращать(ся)
turn into
This notion is formal equivalent to the following:
превращать
превращаться
turn into
However, in the first case «превращать(ся)» will be displayed in the
card; this way of display is methodically better.
If you have marked several heading sections as non-obligatory, the
overall Word List will contain every possible heading variant. For
example, a heading written as follows: (пре)вращать(ся) will be
displayed in the overall Word List in four variants: превращаться,
превращать, вращаться and вращать.
Attention! We advice you not to use the brackets in the heading for any
other purpose but the described above.
For details see:
How the headings are sorted

Subentry
You can specify a subentry in a card body. A subentry is used to present
some widely used expressions and phrases with the card headword.
Alike to card, a subentry has a heading and a body. When the system
displays main card, only the subentry heading is displayed in it, not the
entire subentry. A subentry is displayed in a different color. When you
click this heading another card containing the subentry heading and body
is displayed. The subentry heading is displayed in the overall Word List;
you can display the subentry card if you click on it in the overall Word List
too. It will be as well displayed if you translate the respective expression
from a word processor. A single card can contain several subentries.
A subentry heading must begin with a @ in a new line, while the first line
position must be occupied by a space or a tab. A subentry body is written
according to the same rules as card body, but you must conclude it by a
new line, the first position of which must be occupied by a space or tab
followed by a @ character. The following example shows a card with two
subentries, both of which are entered under respective headword
meaning:
Ex.1:
little
1) маленький
@ little one
малыш
@
2) немного, мало
3) пустяк, мелочь
@ little by little
мало-помалу, постепенно
@
A subentry heading can contain alternative and/or unsorted part. These
parts are only displayed only when you display the subentry card.
In DSL all subentries are considered to be displayed only in full

translation mode - they are included in «[*]» ….» [/*]» tags, as shows the
Ex.2. If you want your user dictionary resemble Lingvo dictionary, do the
same with your dictionary.
Ex.2:
little
1) маленький
[*]@ little finger
мизинец
@ little ways
маленькие, смешные слабости
@
[/*]
NB: If a card contains several running subentries (as in the Ex.2), the
beginning of a new subentry is the end of the previous subentry. In this
case you can put only one "at sign" (@).

Using tilde
As you have noted, we retyped the headingword whenever we needed it
in the card text of the previous section examples. There is a way to avoid
such retyping, and that's the tilde use. If you type a tilde (~) in any card
part (for example, in a subentry header), this tilde will be replaced with
the card heading when displaying the card text or subentry card. NB! If
there is more than one heading in a card, the first one will be used to
replace the tilde. See the following example: the card "binary" can be
written as follows:
binary
бинарный
@ ~ search tree
бинарное дерево поиска
@ ~ search
бинарный поиск
@
You can use tilde in the text of a single card as many times as you want.
You can even use multiple tildes in a single subentry heading (for
example, you can have the following subentry - ~ in ~ - in the "all" card,
equivalent to "all in all").
A tilde used in the subentry text is replaced with the card, not subentry
header.
If a card's heading contains an unsorted part (or parts), any tilde used in
the card text will be replaced with the longest sorted heading part.
A ^ sign typed before a tilde changes the case of the first letter of the
word the tilde is to be replaced with - if the first letter were capital, it'll
become small, and vice versa. See the following example:
Havana
Гавана, столица Кубы
@ ^~

гаванская сигара
@

Reference to another card
A card or subentry (subcard) can contain a reference to another card (for
example, a synonym or antonym). To create a reference (hyperlink) you
should type one of the headings of the card referenced to in the body of
your card enclosing it in broken brackets. A word in broken brackets may
be placed in any part of the card but in subentry heading; you aren't
obliged to put it in the beginning of a line. When it comes to displaying a
card, a reference isn't marked with any specific sign but displayed in the
same color as subentry heading. When you click it another card with the
word's translation opens.
For example, the following card contains a reference to the word "binary":
data
данные, см. также <<binary>>
If you create a reference to a card, the heading of which contains an
unsorted part, you can refer to any of the respective heading variants. In
any case, the unsorted heading part must be suppressed.

Comments
You can enter comments in the source text of the dictionary; these
comments are ignored by compiler. Any DSL expressions present in
comments are ignored too. A comment is entered in double braces.
Several lines of the source text may be included in braces..
{{An example of two-headings card}}
sale price
selling price
отпускная цена
A comment may begin in any part of a line, also braces may be entered
in any part of a line. The only restriction is that comments must not divide
an entry (card) or subentry heading (but they may be entered in the same
line after the heading). A line containing a comment in its first position
cannot contain an card heading, but you may enter a subentry heading
after the comment in this line.
It is forbidden to use embedded comments (i.e., you cannot enter a
comment inside another one).

Grammar and other labels
You can specify certain words or abbreviations having a special definition
in a card; these words are called “labels” and are identical to grammar
labels used in Lingvo dictionaries. When you position the mouse pointer
on such a label a question mark appears. Press the left button to display
a small window alike a tooltip window showing the definition of the label.
For example, v. - verb.
The list of already implemented labels used in our system dictionaries is
a DSL-dictionary - abbrev.dsl which you can find in root Lingvo folder.
Follow these steps to mark a label in a card:
1. Select the label in the card body using [p] tag. The respective switchoff tag is [/p]. The example has v. label displayed in italics and in a
special colour:
[c][i][p]v.[/p][/i][/c]
Note: Items 2-4 are required if the label you’ve entered is not
already in abbrev.dsl dictionary.
2. Enter the necessary changes to abbrev.dsl file (New label is an card
heading in a abbrev.dsl dictionary. The card body should contain the
text defining the label; this text will be shown when you click that
particular label in the card).
3. Compile abbrev.dsl with DSL-compiler.
4. Put the dictionary compiled to Lingvo folder abbrev.lsd.

How to insert picture or sound in a DSL dictionary entry
You can insert picture or sound file in a DSL dictionary entry (card). When
you display this card the picture or the sound file will be replaced with the
icon. Click the icon to display the picture in a separate window or to listen
to the sound.
The source image or sound file should be located either in the Lingvo
directory or dictionary directory.
To insert a picture in a DSL dictionary entry:
Write the name of an image file followed by the tags of multimedia
zone.
Ex: [s]mypicture.bmp[/s].
Supported image formats:
BMP, Bitmaps (*.bmp)
PCX (*.pcx)
DCX (*.dcx)
JPEG (*.jpg)
TIFF (*.tif)
To insert a sound in a DSL dictionary entry:
Write the name of a sound file followed by the tags of multimedia
zone.
Ex: [s]mysound.wav[/s].
Important! A sound card compatible with your operating system should
be used for listening sound files.

Supported sound formats:
Wave Sound (*.wav)

How to insert reference to a web-page
To insert reference to a web-page:
Write the address of a web-page followed by the [url], [/url] tags.
E.g.: [url]http://www.lingvo.ru[/url].
The reference text of the card is underlined and marked with the color
(the same as the color of references to other cards). You can change the
color on the Format tab of the Options dialog (menu Tools>Options).
Click the reference to open the web-page in a default Internet browser.

Text formatting
The new DSL version features special text formatting tools called
formatting tags. Any formatting tool has two commands: toggle on tag
and toggle off tag. Depending on this, the text entered between these
tags will be formatted in a certain manner.
Any toggle on tags look like «[a]», a - is a formatting tool tag (comprising
either on or two characters). The respective toggle off tag looks like
«[/a]».
Implemented are the following text formatting tools:
boldfaced text («b» tag);
italics («i» tag);
underlined text («u» tag);
colored text («c» tag; available colors: Aliceblue, antiquewhite, aqua,
aquamarine, azure, beige, bisque, blanchedalmond, blue, blueviolet,
brown, burlywood, cadetblue, chartreuse, chocolate, coral,
cornflowerblue, cornsilk, crimson, cyan, darkblue, darkcyan,
darkgoldenrod, darkgray, darkgreen, darkkhaki, darkmagenta,
darkolivegreen, darkorange, darkorchid, darkred, darksalmon,
darkseagreen, darkslateblue, darkslategray, darkturquoise,
darkviolet, deeppink, deepskyblue, dimgray, dodgerblue, firebrick,
floralwhite, forestgreen, fuchsia, gainsboro, ghostwhite, gold,
goldenrod, gray, green, greenyellow, honeydew, hotpink, indianred,
indigo, ivory, khaki, lavender, lavenderblush, lawngreen,
lemonchiffon, lightblue, lightcoral, lightcyan, lightgoldenrodyellow,
lightgreen, lightgrey, lightpink, lightsalmon, lightseagreen,
lightskyblue, lightslategray, lightsteelblue, lightyellow, lime,
limegreen, linen, magenta, maroon, mediumaquamarine,
mediumblue, mediumorchid, mediumpurple, mediumseagreen,
mediumslateblue, mediumspringgreen, mediumturquoise,
mediumvioletred, midnightblue, mintcream, mistyrose, moccasin,
navajowhite, navy, oldlace, olive, olivedrab, orange, orangered,

orchid, palegoldenrod, palegreen, paleturquoise, palevioletred,
papayawhip, peachpuff, peru, pink, plum, powderblue, purple, red,
rosybrown, royalblue, saddlebrown, salmon, sandybrown, seagreen,
seashell, sienna, silver, skyblue, slateblue, slategray, snow,
springgreen, steelblue, tan, teal, thistle, tomato, turquoise, violet,
wheat, white, whitesmoke, yellow, yellowgreen, - colors supported by
Microsoft Internet Explorer 4.0 or higher.
A color name is not enclosed in quotation marks. If a color name is
not specified, the color specified in ABBYY Lingvo shell as the label
color is used, e.g.: [c],[c green];
your text will be black if you specify the color without tags.
The following example makes «отпускная» displayed in italics, «цена»
as boldfaced, and the overall card («отпускная цена») as underlined.
selling price
[u][i]отпускная[/i] [b]цена[/b][/u]
Mind the fact that spaces before, after and in the middle of tags are
present only if actually intended to be displayed. That means that you
can format, if you want, only a part of the word (a single letter, the first
and the last letters, etc.). If there is a space before and after a tag, only
one space will be actually displayed.
The formatting tags must not overlap. If you toggled one formatting tag
before another, you must toggle it off after the latter.

Paragraph formatting
When displaying a card text Lingvo system formats each paragraph
according to card window width. Paragraph margins are defined as
follows:
each line is single paragraph;
subentry mark «@» is the beginning of a paragraph.
In other words, each first paragraph line begins in the first position of the
card window while the rest of the paragraph is divided into lines (ending
with a complete word) the length of which depends on the card window
width.
You should specify the left paragraph margin (counted from the left card
window margin) using «[mN]» tag (N is any digit from 1 to 9). Any
paragraph from this tag until the end of card or until system meets an
«[/m]» (margin shift toggle off) tag, will be displayed positioned N spaces
to the right from the left card window margin.
For example, if you want to display translation one space to the right from
the card header, you should format the card as follows:
little
[m1]1) маленький[/m]
[m1][*]@ little one
малыш
@
[/*][/m]
[m1]2) немного, мало[/m]
[m1]3) пустяк, мелочь[/m]
[m1][*]@ little by little
мало-помалу, постепенно
@

[/*][/m]

DSL tags
All tags look like the following: «[a]». "a" is a particular tag symbol,
toggling a particular mode on. The respective toggling-off tag looks like
«[/a]».
[b], [/b] - boldfaced type.
[i], [/i] - italics.
[u], [/u] - underlined type.
[c], [/c] - colored (highlighted) type.
[*], [/*] - the text between these tags is only displayed in full translation
mode (see); sample translations etc. are usually marked by these tags.
[mN] - this tag sets the left paragraph margin (counted from the left card
margin). N is any digit from 0 to 9. N spaces will separate the left margin
of any paragraph entered between this tag and its toggle-off tag («[/m]»)
and left card margin. The toggle-off tag must be entered explicitly.
[trn], [/trn] - to mark a translation section.
[ex], [/ex] - to mark a sample section.
[com], [/com] - to mark a comment section.
[s],[/s] - to mark a multimedia section (it is used to insert pictures or
sound files into a dictionary entry (card)).
[url],[/url] - to insert reference to a web-page.
[!trs], [/!trs] - the text between these tags will be excluded from indexing,
and, respectively, from full-text search.
[p], [/p] - labels marking (when a label is pressed a window with its
definition appears).

[lang][/lang] - the language of a word or a phrase; you must specify it for
the words in the card that are written in other language than the one
specified for the dictionary entry (if you do so, such words will be
available for full-text search, translation, etc.) Parameters: language
name or language ID (say, [lang id=1]). The language name must be
enclosed in brackets, for example [lang name="Russian"]. See the list of
supported DSL languages in "Supported languages" section.
[ref][/ref] - reference to a card in the same dictionary (you may also use
<< and >> signs to enclose the card heading to make a reference).
[sub][/sub] - subscript.
[sup][/sup] - superscript.
Note: According to DSL language rules the embedding of index zones,
as well as formatting commands of one and the same type, is forbidden.

Dictionary indexing
Lingvo system indexes a dictionary either when a search query is issued,
or when it is directly asked to do so (for example, when a dictionary is
attached). User dictionaries are indexed in the same manner as Lingvo
system dictionaries are.
In order for the dictionary content to be present in search result, you have
to specify indexing tags in the card body. If you don't use tags in the card
body, only card heading will be used in search. Lingvo system regards
entire indexing section as a single search area.
The translation section is marked in «[trn]» and «[/trn]» tags. Only
words serving as direct translation equivalents should be included in this
section (submeaning numbers are excluded form this).
The example section is marked in «[ex]» and «[/ex]» tags.
The comment section contains some additional information about the
translation equivalents. It is marked in «[com]» and «[/com]» tags.
There can be some text in a dictionary entry which you would like to
exclude from indexing (for example, citations from other entries). To
exclude a portion of text from indexing use «[!trs]» and «[/!trs]» tags.
Create dictionary indexed by default (DSL Compiler dialog) option
enables indexing zones to be entered in the card body automatically.
It is done in the following way - the complier, at the time of its launch,
enters translation zone on-tag [trn] at the beginning of the card and
translation zone off-tag at its end. If there will be other [trn] tags
encountered in the card body (these entered by user) the card won’t be
compiled and an error message will be issued, as embedding of indexing
zones of one and the same type is forbidden in DSL language. On the
contrary, if there will be comment or example tags encountered in the
card, everything will be alright.
So, if the query text was found in comment or example zone, the card

heading will be displayed in the respective section of the Search dialog.
For details see:
How to compile a dictionary

How to compile a dictionary
A .dsl file that contains a dictionary should be compiled with the DSL
compiler.
To start DSL Compiler:
Click Start button on the Taskbar and select Programs/ABBYY
Lingvo/DSL Compiler. The DSL Compiler dialog box will open.

LUD option is available only if .adc custom dictionaries of previous
Lingvo versions are being compiled. To execute the compilation correctly
one should have the corresponding .adt file.
Differences between LUD and LSD dictionary types:
LUD-dictionary
LUD-dictionary have a very simple
structure: there is a word and its
translation without any formatting.
An entire dictionary entry is indexed

LSD-dictionary
When compiling an LSDdictionary, you can use special
DSL tags of indexing zones and
text formatting in the source file

in this case.
You can't modify LSD-dictionary
You can fill up LUD-dictionary
with the means of Lingvo. To
directly from the Lingvo shell (select
change this dictionary, you should
Create/Edit Card... item from the
modify the source file and than
Tools menu).
compile it again.

The whole dictionary consists of
three files with .lud, .adx and .ann
extensions.
The first two files are compulsory,
they contain the dictionary index
and entries. The third one with
dictionary annotation is optional.

The whole dictionary is only one
file with the .lsd extension.

It occupies less disk space.

Select necessary options and click the Compile button. When the
compilation is over, you get two new files (а .dde file and an .lsd file). We
advise you to correct encountered errors and warnings and recompile
your dictionary.
To attach an lsd or lud dictionary to the current version of Lingvo:
Select Languages & Dictionaries... from the Tools menu. In the
opened Languages & Dictionaries... dialog you can attach all
necessary dictionaries.
Compiling the dsl-files created for previous versions of DSL
compiler
All you have to do to successfully compile an old dsl-format file is to put
the following heading at the beginning of the dsl-file:

dictionary name;
source language;
target language;
codepage.
Say, in case of an English-Russian dictionary LingvoTest this info must
look like this:
#NAME "LingvoTest"
#INDEX_LANGUAGE "English"
#CONTENTS_LANGUAGE "Russian"
#SOURCE_CODE_PAGE "Cyrillic"
If you have words belonging to different languages in the cards of your
user dictionary, you should mark up these fragments using language tags
(See DSL tags for details).
For details see:
"About Dictionary" Dialog

Supported languages
ABBYY Lingvo English-Russian Edition
Language
English*
Russian*

Language name ID
English
1
Russian
2

ABBYY Lingvo Multilingual Edition
Language
Afrikaans
Basque
Belarusian
Bulgarian
Czech
Danish
Dutch
English*
Finnish
French*
German*
German (New spelling)*
Hungarian
Indonesian
Italian*
Norwegian (Bokmal)
Norwegian (Nynorsk)
Polish
Portuguese
Russian*

Language name
Afrikaans
Basque
Belarusian
Bulgarian
Czech
Danish
Dutch
English
Finnish
French
German
GermanNewSpelling
Hungarian
Indonesian
Italian
NorwegianBokmal
NorwegianNynorsk
Polish
PortugueseStandard
Russian

ID
15
9
21
22
18
13
10
1
11
4
3
26
19
16
5
14
25
20
8
2

Serbian (Cyrillic)

SerbianCyrillic

23

Spanish (Modern Sort)*

SpanishModernSort

6

Spanish (Traditional Sort)* SpanishTraditionalSort 7
Swahili
Swedish

Swahili
Swedish

17
12

Ukrainian*

Ukrainian

24

Morphology is supported for boldfaced languages.
* For these languages the viewing and adding of paradigm is available
besides morphology support.

Sample DSL entries
abandon
[b]1.[/b] [p][i][c][com]гл.[/com][/c][/i][/p]
[m1]1) [trn]покидать, оставлять; самовольно уходить ([i][com]с
поста и т. п.[/com][/i])[/trn][/m]
[m2][*][ex][lang id=1]to abandon ship[/lang] — покинуть
корабль[/ex][/*][/m]
[m2][*][ex][lang id=1]Audacity abandoned him.[/lang] — Смелость
покинула его.[/ex][/*][/m]
[m2][*][b]Syn:[/b][/*][/m]
[m2][*][ref]forsake[/ref], [ref]desert[/ref] I, [ref]leave[/ref][/*][/m]
[m1]2) [trn]отказываться ([i][com]от чего-л.[/com][/i]), прекращать
([i][com]что-л., делать что-л.[/com][/i])[/trn][/m]
[m2][*][ex][lang id=1]They abandoned their native language.[/lang]
— Они перестали говорить на своем родном языке.[/ex][/*][/m]
[m2][*][ex][lang id=1]They abandoned the escape.[/lang] — Они
отказались от побега.[/ex][/*][/m]
[m2][*][b]Syn:[/b][/*][/m]
[m2][*][ref]leave[/ref] II[/*][/m]
[m1]3) [trn]сдавать, оставлять[/trn][/m]
[m2][*][ex][lang id=1]to abandon that place to the merciless
enemy[/lang] — сдать это место безжалостному врагу[/ex][/*][/m]
[m1]4) [p][i][c][trn][com]юр.[/com][/c][/i][/p] передавать страховым
компаниям все права на застрахованное имущество[/trn][/m]
[m1]5) [p][i][c][trn][com]возвр.[/com][/c][/i][/p] предаваться ([i]
[com]страсти и т. п.; [lang id=1]to[/lang][/com][/i] )[/trn][/m]
[m2][*][ex][lang id=1]He seldom abandons himself altogether to the
inspiration of the poet.[/lang] — Он редко предается поэтическому
вдохновению.[/ex][/*][/m]
[m2][*][ex][lang id=1]to abandon oneself to the idea[/lang] —
склоняться к мысли[/ex][/*][/m]
[m2][*][ex][lang id=1]to abandon oneself to passion[/lang] —
предаваться страсти[/ex][/*][/m]
[m2][*][ex][lang id=1]After her mother died, she abandoned herself
to grief.[/lang] — После смерти матери она впала в отчаяние.[/ex][/*]

[/m]
[m1][*]••[/*][/m]
[m1][*][ex][lang id=1]abandon hope all ye who enter here[/lang] —
оставь надежду всяк сюда входящий[/ex][/*][/m]
[b]2.[/b] [p][i][c][com]сущ.[/i][/p]; [p][i]книжн.[/com][/c][/i][/p]
[m1][trn]импульсивность, страстность; несдержанность,
развязность[/trn][/m]
[m2][*][ex][lang id=1]reckless abandon, wild abandon[/lang] —
безудержная, дикая энергия[/ex][/*][/m]
[m2][*][ex][lang id=1]There was no abandon in their dance.[/lang] —
В их танце не было чувства.[/ex][/*][/m]
[m1][*][b]Syn:[/b][/*][/m]
[m1][*][ref]dash[/ref] I, [ref]enthusiasm[/ref], [com][lang
id=1]unconstrainedness of manner[/lang][/com][/*][/m]
abandoned property
[m1][trn]бесхозная собственность[/trn][/m]
chat
[m1][p][i][c][com]m[/com][/c][/i][/p][/m]
[m1][trn]кот, кошка;[/trn][/m]
[m2][*][ex][lang id=4]Chat botté[/lang] — Кот в сапогах;[/ex][/*][/m]
[m2][*][ex][lang id=4]jouer à chat perché[/lang] — играть в кошкимышки[/ex][/*][/m]
Qualität
[m1][p][i][c][com]f[/p] [p]=[/i][/p], [lang id=3]-en[/lang][/com][/c][/m]
[m1]1) [p][i][c][trn][com]б. ч.[/p] [p]sg[/com][/c][/i][/p] качество,
свойство[/trn][/m]
[m1]2) [trn](высшее) качество; [p][i][c][com]коммерч.[/com][/c][/i][/p]
(высший) сорт;[/trn][/m]
[m2][*][ex][lang id=3]beste Qualität[/lang] — высший сорт;[/ex][/*]
[/m]
[m2][*][ex][lang id=3]von guter Qualität[/lang] —
доброкачественный ([i][com]о товаре[/com][/i]),[/ex][/*][/m]

[m2][*][ex][lang id=3]diese Ware ist Qualität[/lang] — этот товар
высшего качества[/ex][/*][/m]
[m1]3) [p][i][c][trn][com]pl[/com][/c][/i][/p] качества, достоинства ([i]
[com]человека[/com][/i]);[/trn][/m]
[m2][*][ex][lang id=3]ein Mann von Qualitäten[/lang] — вполне
достойный человек[/ex][/*][/m]
Note: To use these examples, please do the following:
1. Copy one of the entries into a text file and correct it so that each line
in the card body (but not the heading) starts with a space (or several
spaces) or a tab (or several tabs);
2. Add the dictionary heading at the beginning of dsl-file. It includes
dictionary name (#NAME "dictionary name"), source
language(#INDEX_LANGUAGE "language name") and target
language (#CONTENTS_LANGUAGE "language name").
Ex.: Write the following heading at the beginning of the text file to
create the English-Russian dictionary named "General":
#NAME "General"
#INDEX_LANGUAGE "English"
#CONTENTS_LANGUAGE "Russian"
3. Save the file as Unicode text and change the file extension to dslformat.
4. Compile this file in the DSL-compiler.

Lingvo system hotkeys
You can quickly accomplish tasks you perform frequently by using
shortcut keys.
Edit menu
View menu
Tools menu
Lingvo Main Window
Card Window
Windows: Translations; Suggestions; Card history; Search
Other
Edit menu
Copy the selection to the clipboard and delete it
from the Edit Line
Copy the selection to the clipboard

CTRL+X
CTRL+C;CTRL+INS

Paste the contents of the clipboard in the Edit Line
CTRL+V;
(available only if you have copied some text into the
SHIFT+INS
clipboard before)
Back to Top
View menu
Arrange open cards so that all headings are visible
Close all cards (temporary and permanent)
Show History
Always keeps the Lingvo Main window above all
other windows

CTRL+A
SHIFT+ESC
CTRL+H
CTRL+T

Back to Top
Tools menu
Open the card of the word selected in the Word List
Translate the word from the Edit Line
Display all the word forms of the word from the Edit
Line
Display spelling suggestions for the word from the
Edit Line.
Search in Dictionaries
Add/remove dictionaries
Specify Lingvo parameters
Add a new card or edit an existing one in a user
dictionary
Delete a word from a user dictionary

ENTER
CTRL+ENTER
CTRL+W
F7
CTRL+F
CTRL+D
CTRL+O
CTRL+Num +
CTRL+Num Back to Top

Lingvo Main Window
Translate the word selected in the Word List
ALT+ENTER
Move to the next word (phrase) in the Word List.
Up arrow
Move to the previous word (phrase) in the Word List Down arrow
Back to Top
Card Window
Make the card permanent
Show a brief translation
Sync contents
Find in card
Repeat the previous search in the card
Go to the previous dictionary

CTRL+T
CTRL+Num *
CTRL+S
F3
ALT+F3
CTRL+P

Go to the next dictionary.
CTRL+N
Copy a word from the opened card to the Edit Line and
sync the Word List (arrange the overall Word List so that
CTRL+ENTER
the headword and the words nearest to it are displayed)
Translate the word from the open card
ENTER
Close the card
ESC
Back to Top
Windows: Translations, Suggestions, Card history, Search
Open the selected word card
Synchronize contents
Clear card history
Search in dictionaries
Change search options
Add search results
Reduce search results
Close the window

ENTER
CTRL+S
CTRL+[-]
CTRL+F
CTRL+O
CTRL+Page
Down
CTRL+Page Up
ESC
Back to Top

Other
Translate a word or a phrase; start Lingvo
Copy text to the Edit Line
Help

CTRL+INS+INS

Ctrl +C+C
CTRL+S
F1
Back to Top

Glossary
Abbreviation
An abbreviated word or phrase.
Active dictionary
Active dictionary is a dictionary used by Lingvo when translating your
queries and performing full-text search. To make a dictionary active,
press on its button on the Bookshelf.
Annotation
Annotations contain comments to dictionaries created by the user. It is a
text file whose extension has been changed to .ann. The name of the
annotation file must be the same as the name of the dictionary for which
it has been written. Annotation files are optional.
Attached (added) dictionary
A dictionary added to the Lingvo system via the Languages &
Dictionaries... dialog.
Each attached dictionary has its own button on the Bookshelf. An
attached dictionary can be either active or inactive.
Bookshelf
The Bookshelf is a toolbar containing all dictionaries available for the
selected pair of languages, either active or inactive.
Card
Card - a window displaying a card of an active dictionary corresponding
to a word or a phrase entered in the Edit Line.
Collocation
Collocation is a recurrent word combination.

Edit Line
A box in the Lingvo Main Window where you type or paste a word you
wish to translate.
Full-text search
Full-text search is a search for a word or a phrase in the whole text of all
cards in all the active dictionaries.
Indexing
The process of building an index. An index is built for every newly added
dictionary, so the added dictionary entries could be used in full-text
searches.
Labels
Labels are used to provide additional information about a word. Lingvo
has part-of-speech labels, usage labels, register labels, etc. If you drag
your mouse cursor over a label, a question mark will appear. Click on the
question mark to see the full text of the label.
Lingvo Agent
Lingvo Agent is a small program that is initiated at system start-up and
that starts Lingvo when you try to translate a word for the first time.
Magic Keys
Hot-keys for Quick translation of words and phrases from external
applications.
Monolingual Dictionary
A dictionary written in only one language. Monolingual dictionaries
include conceptual dictionaries, dictionaries of abbreviations, dictionaries
of phrases, dictionaries of synonyms, antonyms, homonyms, toponyms,
explanatory dictionaries, thesauri, etc.

Paradigm
All the word forms of a word.
Permanent card
A card becomes permanent when you click . Unlike temporary cards, a
permanent card will remain open until you close it manually.
Quick translation
Quick translation is the process of translating words/phrases by pressing
a combination of hotkeys (Magic keys) rather than typing them in the
Edit line.
Source language
Source language is the language from which you are translating. The
source language is chosen from the left-hand drop-down list on the
Lingvo Language bar.
To change the source language, click on the arrow of the drop-down list
and select a new language. Depending on which language you choose,
the set of dictionaries on the Lingvo Bookshelf and the Word List in the
Main window will change accordingly.
Sub-card
A sub-card is a card contained within a main card.
System dictionary
System dictionary - a dictionary supplied as part of the Lingvo distribution
package.
Target language
Target language is the language into which you are translating. The
target language is chosen from the right-hand drop-down list on the

Language bar.
Temporary card
A temporary card closes when you click the Close Temporary Cards
button. By default, all cards you open are temporary.
Thesaurus
Thesaurus is a monolingual dictionary in which words a grouped by
meaning.
This version of Lingvo contains only one thesaurus - The Thesaurus of
Russian Business words where you can find groups of synonymous
words often used in the language of business (e.g. in contracts, technical
documents, business letters, etc.). Such dictionaries are useful when you
are not sure which word to use in a given context. Thesauri can be a
good translation aid when used together with bilingual dictionaries.
Uninflected
Parts of speech whose paradigm consists of only one word form, e.g.
adverbs.
User dictionary
Any dictionary in Lingvo-compatible format (with .lsd or .lud extensions)
created by the user, downloaded from the Internet or acquired from other
sources.
Word List
The overall Word List includes all the words from all active dictionaries.
The words are in alphabetical order.

Other products by ABBYY
FineReader 6.0 Professional is the most popular version in the whole
FineReader series. This is a professional version and its competitive
price makes it a truly unique offer. High quality recognition in automatic
mode, a whole set of tools for editing recognized text (a handy built-in
editor, collation with an image, ergonomic interface of the spell-checking
window, block editing tools) and a wide range of settings for the
recognition module brought this version universal acclaim (see a list of
laudatory reviews and awards at www.abbyy.com.
FineReader 6.0 Corporate Edition. This version has more tools than
FineReader Professional and includes many professional features (e.g.
recognition of barcodes and creation of new languages). Yet the principal
difference lies in the tools for bulk text input: the Corporate Edition
supports network document processing. This useful feature makes it
possible to streamline recognition workload and increase input speed in
case of high input volumes.
FineReader Professional 5 for Mac, developed by ABBYY Software
House and Sound & Vision, Inc., is designed from the ground up as a
Macintosh application and takes advantage of such Mac OS technologies
as QuickTime, Speech, Drag-and-Drop, and Navigation Services.
FineReader 5.0 Sprint is an OEM-version bundled with scanners and
multifunctional devices. The quality of performance in automatic mode is
the same as that of the other versions, yet its functionality is limited and it
provides only basic tools for editing recognition results. The interface is
simple and implements the one-button Scan&Read principle.
FineReader 6.0 Scripting Edition is a development tool allowing its
users to communicate with FineReader 6.0 Professional/Corporate
Edition via the Automation API (Application Programming Interface) in
any COM-compatible development environment like Visual Basic, C++,
or scripting languages.
FormReader is a powerful system for automatic processing of machine-

readable forms filled out by hand. Machine-readable forms include
various checks, bills, registration cards, questionnaires, ballots,
application forms, etc. You can control recognition results using a system
of automatic checks against databases and dictionaries, as well as
automatic validation rules. The final results can be saved to a file or
exported to information management systems through ODBC. The
system can be used for solving a whole range of tasks of varying
complexity, from processing poll results to reading information from
application forms and tax returns. ABBYY FormReader is the solution of
choice at the Pension Fund of the Russian Federation and the Russian
Ministry of Taxes.
FineReader Bank is an automated system for scanning and recognizing
payment orders. It uses a specially developed flexiform technology and
can process flexiforms -- the exact position of fields can vary from one
form to another and the system will still be able to recognize them. The
system detects and recognizes fields containing information to be
processed, and automatically verifies recognition results by performing
checks against databases and dictionaries. The final results can be
exported to external applications and the system itself can be fully
integrated into information management systems. ABBYY FineReader
Bank is used by Russia’s largest banks and hundreds of financial
institutions.
Retrieval & Morphology Engine is a development tool for integrating
full-text indexing, search and morphology analysis into external local and
client-server applications via a 32-bit COM-compatible API-interface. The
Engine supports a wide range of natural languages.
ABBYY Enterprise Forms is a standard client-server solution for bulk
form input powered by ABBYY FormReader. This batch-oriented system
lowers the costs and increases the accuracy of form input, even if you
process tens of thousands of forms per day. ABBYY Enterprise Forms
utilizes a module architecture in which every workstation performs a
certain set of operations. ABBYY Enterprise Forms can easily recognize
multi-page forms of the most complicated structure, or various forms in
the same batch without any pre-sorting. Bulk form input becomes easy
and well-controlled with ABBYY Enterprise Forms.

You can find detailed information about these products on our website at
www.abbyy.com and please feel free to contact us by phone, fax or email:
Phone: (095) 234-4400
Fax: (095) 956-4787
E-mail: sales@abbyy.com.

Technical Support
If you have any questions about using Lingvo, please consult your User’s
Guide and Help file and visit the support section on our website before
contacting technical support. If you could not find the answers to your
questions there, please feel free to write to us at support@abbyy.com or
call us at (095) 234-4400.
The technical support team will need the following information to provide
you with expert advice and assistance:
Your full name
Your company name
Your phone, fax, e-mail
The serial number of your Lingvo distribution package
The build number of your version of Lingvo (see Help/About
Lingvo.../Build)
A general description of your problem (if an error message appeared
when working with Lingvo, please, enclose its full text).
The type of your computer
Windows version
Any other information you consider important or helpful
Some of this information can be gathered automatically by clicking on
Help/About Lingvo/System Info.
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Messages about corrupted index files
To be able to perform full-text searches in user dictionaries, Lingvo builds
an index for each user dictionary you attach to the system. If the index
becomes physically corrupted (this may happen if you temporarily ran
short of free disk space), you need to rebuild the index. Simply remove
the corrupted index files from your system and Lingvo will rebuild the
index when you enter your new query.
To delete the corrupted index:
Click Yes button in the Corrupted Index message box. Index for all
attached custom dictionaries will be built at the first call to search
function.
If you click No button, the index won't be deleted. In that case you won't
be able to use full-text search.
You can delete the corrupted index by using the following Lingvo system
options:
1. Select Languages & Dictionaries... from the Tools menu.
2. Click Index Update button in the Languages & Dictionaries...
dialog box.
The corrupted index will be deleted. The system will rebuild the index
for all attached custom dictionaries.

Listening to the pronunciation of a word
- The LingvoSound dictionary (En-Ru) gives you an opportunity to
listen to the pronunciation of the most common English words. Click on
the loudspeaker button ( ) to hear the headword pronounced in
Received Pronunciation. You can also find this loudspeaker button on
many cards of the LingvoUniversal dictionary (En-Ru).
Note: You will not be able to listen to the pronunciation of words if you
chose not to install the LingvoSound dictionary.
To install the LingvoSound dictionary:
1. Go to Start>Settings>Control Panel and click on Add/Remove
Programs.
2. In the opening window, select ABBYY Lingvo 8.0 English-Russian
Edition (or ABBYY Lingvo 8.0 Multilingual Edition) and click
Change. This starts the Lingvo InstallShield Wizard.
3. Select Change and click Next. In the opening Custom Setup dialog,
select the LingvoSound dictionary, click Next and follow the
program’s instructions.

ABBYY Lingvo 8.0 Dictionaries
Dictionary
Language

Dictionary Name

LingvoUniversal (En-Ru). The Universal Eng
4th ed., revised and expanded. 100 000 ent
House, 2002.
LingvoUniversal (Ru-En). The Universal Rus
LingvoUniversal
5th ed., revised and expanded. 85 000 entri
(Ru-En)
House, 2001.
LingvoEconomics (En-Ru). The English-Rus
LingvoEconomics
Economics. 5th ed., revised and expanded.
(En-Ru)
Software House, 2001.
LingvoEconomics The Russian-English Index for the English-R
(Ru-En)
Economics. 35 000 entries. © ABBYY Softw
LingvoComputer (En-Ru). The English-Russ
LingvoComputer
Computer Science. 4th ed., revised and exp
(En-Ru)
ABBYY Software House, Maslovsky Y.K., 20
LingvoComputer (Ru-En). The Russian-Eng
LingvoComputer
Russian Dictionary of Computer Science. 36
(Ru-En)
Software House, Maslovsky Y.K., 2001
LingvoScience
LingvoScience (En-Ru). The English-Russia
(En-Ru)
3rd ed., revised. 150 000 entries. © ABBYY
LingvoScience (Ru-En). The Russian-Englis
LingvoScience
Russian Scientific Dictionary. 145 000 entrie
(Ru-En)
House, 2001.
LingvoSound
LingvoSound (En-Ru). The Concise English
(En-Ru)
Dictionary. 3rd ed. 5 000 entries. © ABBYY S
LingvoGrammatical (En-Ru). The English-R
LingvoGrammatical
Dictionary. About 500 grammatical entries. ©
(En-Ru)
House, 2002
Polytechnical
Polytechnic (En-Ru). The Comprehensive E
(En-Ru)
and Technical Dictionary. 2nd ed. 200 000 e
LingvoUniversal
(En-Ru)

English–
Russian
Russian–
English

General information

Polytechnic (Ru-En). The Russian-English In
Comprehensive English-Russian Scientific a
125 000 entries. © RUSSO, 1997.
OilAndGas
OilAndGas (En-Ru). The English-Russian D
(En-Ru)
52 000 entries. © VNIIGAS, RAO "GASPRO
OilAndGas (Ru-En). The Russian-English In
OilAndGas
Dictionary on Oil and Gas. 35 000 entries. ©
(Ru-En)
"GASPROM", 1998
Medical (En-Ru). The English-Russian Index
Medical
Russian-English Medical Dictionary. 50 000
(En-Ru)
2000/ Beniumovich M.S., Rivkin V.P. et al.
Medical (Ru-En). The Comprehensive Russ
Medical
Dictionary. 70 000 entries. © «RUSSO», 200
(Ru-En)
Rivkin V.P. et al.
Law
Law (En-Ru). The English-Russian Law Dict
(En-Ru)
«RUSSO», 1998/Andrianov S.N., Berson A.
Law (Ru-En). The Russian-English Index for
Law
Law Dictionary. 20 000 entries. © «RUSSO»
(Ru-En)
Berson A.S., Nikiforov A.S.
LingvoThesaurus LingvoThesaurus (Ru). The Thesaurus of R
(Ru)
3rd ed. 16 000 entries. © ABBYY Software H
Only in ABBYY Lingvo 8.0 Multilingual Edition
Universal
Universal (De-Ru). The Modern German-Ru
(De-Ru)
Dictionary. 5th ed.. 60 000 entries. © Rymas
Universal
Universal (Ru- De). The Modern Russian-Ge
(Ru-De)
Dictionary. 5th ed. 40 000 entries. © Rymas
Polytechnic (De-Ru). The German-Russian
Polytechnical
110 000 entries. © «RUSSO», 1995/Bardysh
(De-Ru)
Bryzgalin N.F. et al.
Polytechnic (Ru- De).The Russian-German
Polytechnical
Russian Polytechnic Dictionary. 95 000 entr
(Ru-De)
Bardyshev G.M., Baron L.I., Bryzgalin N.F. e
The German-Russian Law Dictionary. 46 00
Law
1995, with Supplement/Grishaev P.I., Donsk
Polytechnical
(Ru-En)

RussianRussian

(De-Ru)

GermanRussian
RussianGerman

Law
(Ru-De)
Medical
(De-Ru)
Medical
(Ru-De)
Chemistry
(De-Ru)
Chemistry
(Ru-De)
Economics
(De-Ru)
Economics
(Ru-De)
Universal
(Fr-Ru)
Universal
(Ru-Fr)
Technical
(Fr-Ru)

French-Russian

Technical
(Ru-Fr)

M.I. et al.

Law (Ru- De). The Russian-German Index f
Law Dictionary. 20 000 entries. © «RUSSO»
/Grishaev P.I., Donskaya L.I., Marphinskaya
Medical (De-Ru). The German-Russian Med
entries. © «RUSSO», 1995/Bolotina A.J., Ga
Dobrovolski V.I. et al.

Medical (Ru-De).The Russian-German Inde
Medical Dictionary. 40 000 entries. © «RUSS
Ganiushina E.G., Dobrovolski V.I. et al.
Chemistry (De-Ru). The German-Russian D
and Chemical Technology. 56 000 entries. ©
2000/Zhukova T.B., Melnikova M.M., Potapo
Chemistry (Ru- De). The Russian-German I
Russian Dictionary of Chemistry and Chemi
entries. © «RUSSO», 2000/Zhukova T.B., M
I.I. et al.
Economics (De-Ru). The German-Russian D
50 000 entries. © «RUSSO», 2001/Kukolev
Economics (Ru-De).The Russian-German In
Russian Dictionary of Economics. 30 000 en
Kukolev J.I.
Universal (Fr-Ru). The Universal French–Ru
entries. © Raevskaya O.V.., 2001.

Universal (Ru-Fr). The Universal Russian-Fr
entries. © Raevskaya O.V., 2000.
Technical (Fr-Ru). The French–Russian Tec
entries. © «RUSSO», 1995/Bolotin A.A., Vor
A.V. et al.
Technical (Ru- Fr). The Russian-French Inde
Russian Technical Dictionary. 55 000 entries
Bolotin A.A., Voropaev N.D., Gorbunov A.V.

Russian-French

Law
(Fr-Ru)
Law
(Ru-Fr)
Chemistry
(Fr-Ru)
Chemistry
(Ru-Fr)

Italian-Russian
Russian-Italian

Polytechnical
(It-Ru)
Polytechnical
(Ru-It)

Law (Fr-Ru). The French-Russian Law Dicti
«RUSSO», 1995/Machkovski G.I.
Law (Ru-Fr). The Russian-French Index for
Dictionary. 20 000 entries. © «RUSSO», 199

Chemistry (Fr-Ru). The French-Russian Dic
Chemical Technology. 65 000 entries. © «R
O.L., Bespalov A.L., Litvintsev I.J., Ustenko
Chemistry (Ru-Fr). The Russian-French Ind
Russian Dictionary of Chemistry and Chemi
entries. © «RUSSO», 1999/ Altakh O.L., Be
I.J., Ustenko A.A.
Polytechnic (It- Ru). The Italian- Russian Ind
Polytechnic Dictionary. 90 000 entries. © «R
1997/Avramenko B.I., Sokolski J.A.
Polytechnic (Ru-It). The Russian-Italian Poly
000 entries. © «RUSSO», 1997/ Avramenko

Tools
Open card from Word List (ENTER)
Opens the card of a word selected in the Word List.
Translate Text from Edit Line (CTRL+ENTER)
Translates text from the Edit Line. The word or phrase could be in any
grammatical form. If any word from the Edit Line is not found in
dictionaries, Suggestions window displaying spelling suggestions will
open.
Note: During translation and search for variants the system only uses the
dictionaries of the current language (selected on Lingvo Language bar).
Translate Using All Languages (CTRL+SHIFT+ENTER)
Translates text from the Edit Line within all translation directions. (In
Multilingual Edition only.)
Find Text from Edit Line (CTRL+F)
Searches for a word or phrase through the complete text of all cards in
the dictionaries of the current pair of languages. For instance, you may
use this search to translate a phrase present in several entries in
examples or comments.
Search in All Languages (CTRL+SHIFT+F)
Show word paradigm... (CTRL+W)
Opens Paradigm window displaying all the word forms of the word from
the Edit Line.
Note: The paradigm may be displayed for a single word in Edit Line only.
It is impossible to display a paradigm for a word phrase.

Add paradigm...
Builds the paradigm for the word in Edit Line.
Suggest... F7
Opens Suggestions window displaying spelling suggestions.
Note: During the search the system only uses the dictionaries of the
current language (selected on Lingvo Language bar).
Create/Edit Card... CTRL+Num +
Allows to add a new word or edit the existing one in the custom
dictionaries. This option is available only for custom (user) dictionaries,
i.e. ones that were created by using Lingvo dictionary creation tools.
Delete Card... CTRL+Num Deletes a word from the custom dictionary.
Languages & Dictionaries... CTRL+D
Opens Languages & Dictionaries... dialog box. You can add and/or
remove dictionaries in this dialog.
Options... CTRL+O
Opens "Options" dialog box displaying "General", "Magic Keys", "Search"
and "Format" tabs. You can specify Lingvo parameters in this dialog.

View
Arrange cards CTRL+A
Arranges open cards so that all headings are visible.
Close temporary cards SHIFT+ESC
Closes all non-permanent cards. To make a card permanent, click the
button in the left upper card corner.
Close all cards SHIFT+F4
Closes all cards either temporary or permanent.
Previous search results
Opens "Search" window displaying the previous search results.
History CTRL+H
Opens the "Card History" window displaying the list of all opened cards,
as well as search or translate queries issued during the current Lingvo
session.
Always on top CTRL+T
Keeps the Lingvo Main window above all other windows at all times.
Language bar
Lingvo toolbar where current translation direction (source language and
translation language) is displayed.
Dictionary bar
Shows the bookshelf with buttons of all attached dictionaries. An
attached dictionary can be active or inactive. You can activate or

deactivate a dictionary by clicking its button on the Dictionary Toolbar.
The entries of an active dictionary are used in translation and full-text
search.
Toolbar
Displays the Lingvo toolbar.

Bookshelf. Working with dictionaries.
Working with dictionaries
Every attached dictionary has its own button on the Lingvo Bookshelf. To
make a dictionary active/inactive just click its button on the Lingvo
Bookshelf. The words of active dictionaries are used for translation and
full-text searches.
To attach/detach system dictionaries:
1. Go to Start>Settings>Control Panel and click on Add/Remove
Programs.
2. In the opening window, select ABBYY Lingvo 8.0 English-Russian
Edition (or ABBYY Lingvo 8.0 Multilingual Edition) and click
Change. This starts the Lingvo InstallShield Wizard.
3. Select Change and click Next.
4. In the opening Custom Setup dialog, select the dictionaries you
wish to install, click Next and follow the program’s instructions.
To attach/detach the LingvoSound dictionary:
Go to Start>Settings>Control Panel and click on Add/Remove
Programs. In the opening window, select ABBYY Lingvo 8.0
English-Russian Edition (or ABBYY Lingvo 8.0 Multilingual
Edition) and click Change. This starts the Lingvo InstallShield
Wizard. Select Change and click Next. In the opening Custom
Setup dialog, select the LingvoSound dictionary, click Next and
follow the program’s instructions.
Note: Make sure to install the LingvoSound dictionary in the same folder
where ABBYY Lingvo was installed.
Attaching/detaching user dictionaries
You can attach any Lingvo-compatible dictionary, created by yourself,

downloaded from www.lingvo.ru or acquired from other sources.
Every user dictionary you place on the Bookshelf is used for full-text
search. For this purpose an index is built for each user dictionary you add
to the Bookshelf.
Lingvo will start building an index for a new user dictionary that you
placed on the Bookshelf when you enter your first query. This may take
several minutes for large dictionaries containing thousands of words.
When a user dictionary is removed from the Bookshelf, its index is also
removed. Lingvo will remove the index when you enter your first query.
Your user dictionary will be automatically added to the set of dictionaries
of the same translation direction.
If there are no dictionaries of the same language combination as that of
your user dictionary, a new Bookshelf will be created. The new languages
will be added to the list of available languages.
Note: The current language is nor changed when you add a new
dictionary, so you may have to switch to the respective Bookshelf to see
your new dictionary. To do this, select your new dictionary’s source
language on the Language bar.
To attach a user dictionary:
Drag-&-drop its file (with .adc, .lsd or .lud extension) onto the Lingvo
Bookshelf.
Choose Languages & Dictionaries... on the Tools menu.
To detach a user dictionary:
Hold down the ALT key, click on the button of the dictionary you
want to detach and drag it outside of the Bookshelf.
Note: You can make all the dictionaries on the Bookshelf active/inactive.
Right-click on the Bookshelf and select Enable all dictionaries/Disable

all dictionaries from the local menu.
Priority of dictionaries
The place of a dictionary on the Lingvo Bookshelf is important. When
displaying cards with translations, Lingvo first will show cards from the
first dictionary to the left, then from the second dictionary to the left, etc.
To move a dictionary on the Bookshelf:
1. Hold down the ALT key and click on the button of the dictionary you
want to move.
2. Drag the dictionary to a new place.
3. Release the mouse button.
Monolingual dictionaries on the Bookshelf
By default, monolingual dictionaries are shown on the Bookshelf for
which their language is chosen as both the source and target language
(e.g. Russian-Russian) and on the Bookshelves for which their language
is chosen as the source language.
To make monolingual dictionaries appear only on monolingual
Bookshelves:

·

Go to Tools>Languages & Dictionaries... and uncheck Add
monolingual dictionaries of the source language to the Bookshelf.
Now you will see Russian monolingual dictionaries on the Bookshelf only
when you choose Russian as both your source and target language on
the Language bar, English monolingual dictionaries only when you
choose English as both your source and target language on the
Language bar, etc.

Full-text search
ABBYY Lingvo can perform full-text searches for your query word or
phrase in the whole text of all active dictionaries of the current pair of
languages.
How does full-text search work?
Suppose you need to translate the phrase «мастер на все руки» from
Russian into English. There is no such phrase in the Lingvo Word List but
you can perform a full-text search. This phrase may be present in the
examples or comments sections of several dictionary entries. Once you
have seen this phrase and its translations in different cards, you will be
able to choose the translation that best suits your context. Note also that
you can enter your query words in any grammatical form.
To search for a word or a phrase in all Lingvo dictionaries:
Type the necessary word or phrase in the Edit Line and click

.

You can also select the Find Text from Edit Line on the Tools
menu or press CTRL+F.
A Search window appears where you can see a list of cards organized
into several groups:
Cards in which the query words appear as headings. Cards with
one-word headings and cards with multi-word headings are shown
separately;
Cards in which the query words appear in the translations section;
Cards in which the query words appear in the examples section;
Cards in which the query words appear in the comments section.
Note:
1. In the Search window, next to each search result you can see the

name of the dictionary in which the query word has been found.
2. If the number of cards is too large, you can browse the list by
pressing CTRL+Page Down or CTRL+Page Up. You can also use
“Add results” or
“Reduce results” buttons.
To change search criteria:
Click
in the Search window or select the Search tab in the
Tools>Options.
In the Search dialog specify the type of search:
Find cards containing all the words typed in the Edit Line ("AND"search);
Find cards containing at least one word typed in the Edit Line ("OR"search).
Note:
1. If your query contains more than one word, by default the dictionary
performs an “AND” search and ignores the word order.
2. When you perform an “AND” search, you can specify a maximum
distance between the words in the query and ask the system to
match the word order.
3. When you perform an “OR”, the cards that contain the most words
from your query are shown first. Generally, the most relevant results
are displayed in the first group of cards.
4. When you perform an "OR" search, the system will ignore function
words (prepositions, conjunctions, interjections, personal pronouns,
etc.) unless they are found in the same card as at least one nonfunction word from the query. Cards containing only function words
will not be displayed.
ABBYY Lingvo Multilingual Edition can perform full-text searches
using either the current language pair or the languages of all the active

dictionaries
To perform a full-text search using all the languages of all active
dictionaries:
Type your query word or phrase in the Edit Line and press
CTRL+SHIFT+F or choose the Search in All Languages on the
Tools menu.

Edit
Cut CTRL+X
Copies the selection to the Clipboard and deletes it from the Edit Line.

Copy CTRL+C
Copies the selection to the clipboard.

Paste CTRL+V
Pastes the contents of the Clipboard in the Edit Line. This command is
available only if you have copied some text into the Clipboard before.

Help
Help topics
The help file contains a user's guide to ABBYY Lingvo and a detailed
description of ABBYY Lingvo features.
There are three ways to get the information on a particular topic - you can
use:
help contents,
index;
full-text search.
Web-links

On-Line Registration

The registration form from our web-site will be open. You can became a
legal user of ABBYY Lingvo 8.0 by filling in the enclosed form.
Web-links

On-Line Technical Support

Here you can find ABBYY Software House address, phone number and
e-mail address.
Web-links

ABBYY Homepage

At www.abbyy.com you can find detailed information about ABBYY
products, ABBYY company and projects run by ABBYY.
Web-links

Lingvo Homepage

ABBYY Software House is glad to present the official Lingvo site:
www.lingvo.ru.
You can send us your dictionaries created in DSL format to be used as
freeware and freely distributed. ABBYY assumes no responsibility
whatsoever for the contents of uploaded dictionaries.
About Lingvo

A brief information about the system is displayed.

Magic Keys and Office Clipboard
When you use the Magic Keys (CTRL+INS+INS or CTRL+C+C) to
translate words from MS Office 2000/XP applications (Word, Outlook,
etc.), the Clipboard toolbar may appear. In MS Office 2000 you cannot
make the Clipboard toolbar appear always in the same place of your
screen. This problem has been solved in MS Office XP and if you are
using this latest version of MS Office you can attach the Clipboard to the
toolbar.
If you are using MS Office 2000 and are not satisfied with the way the
Office Clipboard works, you can force it not to appear when pressing the
Magic Keys. The Office Clipboard will retain its full functionality, but will
not appear when you press CTRL+INS+INS or CTRL+C+C. You can
restore the default Office Clipboard options if necessary.
To disable the Office Clipboard:
Open the Support folder located in the folder where you installed
Lingvo and click on AutoPopupClipboardToolbarOff.reg. Click Yes
when the system prompts you.
To enable the Office Clipboard:
Open the Support folder located in the folder where you installed
Lingvo and click on AutoPopupClipboardToolbarOn.reg. Click Yes
when the system prompts you.

Main Lingvo window

The Main Window toolbar comprises the following buttons:
Open Card from Word List ENTER
Translate Text from Edit Line CTRL+ENTER
Create/Edit Card CTRL+Num+
Search in Dictionaries CTRL+F
Displays all the word forms of the word from the Edit Line CTRL+W
Close Temporary Cards SHIFT+Esc
Always on Top

More:
Keeping the bookshelf in order

"New dictionary" dialog
Option
name
Dictionary
name
Source
language
Target
language
About

Option value

Dictionary name.
Specifies the language for dictionary headings - "from what
language the text is translated".
Specifies the language for cards - "into what language the
text is translated".
Short information about dictionary

See the full list of supported languages in the "Supported languages"
section.

Supported languages
Language
Afrikaans
Basque
Belarusian

Language name
Afrikaans
Basque
Belarusian

ID
15
9
21

Bulgarian
Czech
Danish
Dutch
English*
Finnish
French*
German*
German (New spelling)*
Hungarian
Indonesian
Italian*
Norwegian (Bokmal)
Norwegian (Nynorsk)
Polish
Portuguese
Russian*
Serbian (Cyrillic)

Bulgarian
Czech
Danish
Dutch
English
Finnish
French
German
GermanNewSpelling
Hungarian
Indonesian
Italian
NorwegianBokmal
NorwegianNynorsk
Polish
PortugueseStandard
Russian
SerbianCyrillic

22
18
13
10
1
11
4
3
26
19
16
5
14
25
20
8
2
23

Spanish (Modern Sort)*

SpanishModernSort

6

Spanish (Traditional Sort)* SpanishTraditionalSort 7
Swahili
Swedish
Ukrainian*

Swahili
Swedish
Ukrainian

17
12
24

Morphology is supported for boldfaced languages.
* For these languages the viewing and adding of paradigm is available
besides morphology support.

"About Dictionary" Dialog
After you click the Compile button in the DSL Compiler dialog, Lingvo
will analyze your old dictionary and display the results in the About
Dictionary dialog:

In this dialog you can change the name of the dictionary, its source
language and its target language.
When compiling a new .dsl dictionary you will see the same About
Dictionary dialog telling you that the dictionary has been successfully
compiled. The dictionary parameters displayed in this dialog cannot be
altered because they are explicitly specified in the source DSL code.
More:
How to compile a dictionary
Attaching and converting user dictionaries created in previous versions of
Lingvo

